Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional

Ver. 4.5

Instruction Manual

Content of this Instruction Manual

DPP stands for Digital Photo Professional.

In this manual, the screens used in the basic
operation instructions are from Windows 8.1.

» indicates the selection procedure of the menu.

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.

Click to move to the relevant page.

indicates the function for advanced

users who are experienced in handling image

processing software.

"2 : Marks helpful information when a problem
arises.

-
~

/T

: Marks tips for using the software skillfully.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

AN/

=ING)

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ : next page
() : previous page
: return to a page you had previously
displayed

Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.
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Introduction

Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

* indicates processing that can be performed with JPEG or
TIFF images as well as RAW images.

View and organize images

Adjust an image
Various image adjustments while maintaining the original image

Freely apply a Picture Style

View your image before and after adjustment in the same window

Trim and adjust the angle of an image

(trimming)

Resize an image
Correction of lens aberration

Digital Lens Optimizer
Automatic/manual dust erasure processing

JPEG/TIFF

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print an image
Link with EOS Utility for remote shooting

Color management compatibility
CMYK simulation for commercial printing
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System Requirements

Supported Images

Image data
Image type Extension
RAW | Images in the Canon RAW format shot CR2
Still | images | on supported cameras :
photos | JPEG | Exif 2.2, 2.21 or 2.3-compatible JPEG JPG
images | images '
: : : MOV,
Movies Movies shot with supported cameras MP4

gfggﬁ“;’aﬁ“g Windows 10, Windows 8.1, Windows 8, Windows 7*

Model PC with one of the above OS preinstalled
(Upgraded machines not supported)

CPU Core 2 Duo 2.0 GHz or higher (recommended Core i
series or later)

RAM 2.0 GB or more of RAM (4.0 GB or more

(memory) recommended)

Hard disk Installation: Min. 300 MB of available space

drive Operation: Min. 600 MB of available space
Resolution: XGA (1024 x 720) or more (1600 x 1200

Display or more recommended)
Colors: 16-bit color (65536 colors) or more

May also be installed on a 32-bit version PC, but with restrictions on
operation. On 32-bit OSs, (32bit) is displayed on the [About Digital
Photo Professional 4] in [Help]. For information on restrictions, see
descriptions indicated with in this manual.

* With Microsoft .NET Framework 4.5 installed

Supported Cameras

EOS-1D X Mark I, EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds
Mark 11, EOS-1D Mark IIl, EOS 5DS/EOS 5DS R, EOS 5D Mark 1V,
EOS 5D Mark Ill, EOS 5D Mark I, EOS 6D, EOS 7D Mark Il, EOS 7D,
EOS 80D, EOS 70D, EOS 60D/EOS 60Da, EOS 50D, EOS 760D, EOS
750D, EOS 700D, EOS 100D, EOS 1300D, EOS 1200D, EOS 650D,
EOS 600D, EOS 550D, EOS 500D, EOS 450D, EOS 1000D, EOS
1100D, EOS M5, EOS M3, EOS M2, EOS M, EOS M10, PowerShot G3 X*,
PowerShot G1 X Mark II*, PowerShot G7 X*, PowerShot G9 X*,
PowerShot SX60 HS*, PowerShot G5 X*, PowerShot G7 X Mark II*,
PowerShot G16*, PowerShot S120*, and PowerShot G1 X*

* For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if notin
the camera, can be used with the exception of some functionality.
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Adjusting Color Tone Using Click White
BalanCe........cooviiiiii
T Adjusting White Balance with Color
Temperature ..........oooovveeiiiiiee e
Tuning White Balance...............cc..............
Adjusting Contrast .........cccooeiiiiiiiiii
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Adjusting Dynamic Range........................
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Automatically ..o
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Editing with the Tone Adjustment Tool
Palette.......ooo
Adjusting Brightness and Contrast ........................
Adjusting Color Tone Using Click White
BalanCe.......ccooiiiiiii
Adjusting Tone Curve..........cccceeeeeeeinnnnnnn.
Adjusting Dynamic Range........................
Using the Auto Lighting Optimizer ........................
Editing with the Color Adjustment Tool
Palette.......... oo,
Editing with the Color Adjustment Tool
Palette.. ...
Editing with the Detailed Adjustment
Tool Palette..........uoiiii e,
Reducing NOISE ........coiiii
Adjusting Image Sharpness..........cccceeeeeeeeeeeeneeen.

Editing with the Trimming/Angle
Adjustment Tool Palette ............ccooiiiiiiiiii
Editing with the Lens Correction Tool Palette.............
Correcting Lens Aberration............ccccooeeeiiiiiiinnnnnnnn.
Making Corrections.............ccceeeeiiiiiiiiiiiicee e,
Shooting Distance Information Slider .....................
Correcting Multiple Images ata Time....................
Digital Lens Optimizer ............ccccooiiiiiiiieeeee,
Using the Digital Lens Optimizer............ccccceeeeeee.
Adjusting Image Sharpness.........ccccccoeevvvivvceeeeen.n.
Editing with the Dust Delete/Copy Stamp
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Performing Automatic Dust Erasure Processing ....
Automatic Dust Erasure Processing in the Main
WINAOW ...
Manually Erasing Dust (Repair Function)...............
Erasing Unwanted Parts of an Image (Copy
Stamp FUNCLON) .......ooiiiiiiiii s
Setting Work Color Space ..........ccoevvvvvceeieieeeieeeiinn.
Using the Soft-Proof Colors Function.........................
Saving Editing Results...........ccccccvvvvvnnnnnees
Saving Editing Contents to an Image .....................
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Re-Editing an Image.........ccccccciiiiiniinieens

Utilizing Adjustment Contents (Recipe).....
Copying a Recipe and Applying to Another
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Creating HDR (High Dynamic Range)

Using the Dual Pixel RAW Optimizer.........
Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
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RAW Fil€...ueieeieeeeeeeee e
Reposition the Viewpoint or Foreground Bokeh
for a More Pleasing Result ...,
Reduces the Appearance of Ghosting in

Transferring a RAW Image to
PhotoShOp.....ccovuii e

Customizing the Main Window Toolbar......

S Printing IMages........ccoouviiiiiiiiii e
Printing an Image...........ccoooiii
Printing with Shooting Information..........................
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GlOSSANY ...t 136
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About This Instruction Manual.................c.c.......... 142

Trademarks ........ccceeeeeeiiciiieee e 142

* Sections with and in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image

editing.
: All the functions explained in the section support

JPEG/TIFF image editing.

: Certain functions explained in the section support

JPEG/TIFF image editing.
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1 Downloading Images
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Starting up DPP

Double-click the desktop icon.

A

This PC

%

Network

Double-click

DPP starts up and the main window (thumbnail layout) appears.

v

Main window (thumbnail layout)

@ If you drop a DPP-supported image file onto the icon on the
desktop, you can start up DPP and display the folder where the
image file is saved.

R
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Downloading Images to Your Computer

Download the images saved on the memory card inserted in the

camera.

Downloading Images Using the Software “EOS Utility”

You can download images with “EOS Utility”, communication software

for the camera.

For detailed instructions on downloading images, refer to the “EOS
Utility Instruction Manual” (PDF electronic manual).

Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.
Start up DPP beforehand.

Open [My Computer] » [EOS_DIGITAL] and drag the
[DCIM] folder to the [Desktop].

& Digital Photo Professional 4 - [Folder: 1:\DCIM]

File Edit View Thumbnails Preview Label Adjustm: ols  Windd|

Re

All images are saved in folder units inside the [DCIM] folder.
Copying images to your computer will take some time when there
is a large number of images saved on the memory card.
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D Viewing Images

|

Viewing Images in the Main Window (Thumbnail Layout) ........... 11
Changing the Thumbnail Display............ccccccvvvvvvvnnnnes 12
Using the Thumbnails Control Panel ........ 13
Using the Thumbnail Display Filter/Sort
FUNCLON ..., 14
Displaying the Histogram Palette.............. 15
Enlarging and Viewing an Image in the Preview Window ............ 16
Enlarging and Viewing a Specific Area....................... 17
Displaying the Navigator Palette................ 17
Checking the Image in Detail ...................... 18
Displaying the Main Window (Multi-layout)................. 18
Checking an Image Using the Preview Control Panel......... 19
Changing the Magnification ..............cccccccvvveeeeenn.... 19
Comparing with a Pinned (Fixed) Image ................ 19
Displaying Multiple Images at the Same Time ....... 20
Displaying Grid Lines............coooiiiiiiiiiiiiiieeeee s 20
Displaying AF Points ..........cccoociiiiiiiiieeee e, 20
Displaying Areas Beyond the Set Range with Warning
Indicators (Highlight/Shadow Warning) .................. 21
Comparing Pre- and Post-Editing Images (Single-
Image Display)......cceeeeeeiiiiiiiiiieeeeeeee e 21

Comparing Pre- and Post-Editing Images (before/after
comparison) Arrange vertically/horizontally (two-
screen display) / Split vertically/horizontally (split-

image disSplay) ....ccccueeeeeiiieeieee e 22
Displaying Image Properties...........ccccceveeeeeeeiinennnn. 22
Checking an Image in Multi-Function Preview ........... 23
Checking an Image in Second Windows.................... 24

Opening and Closing Window Panels (Panes)........ 25

Changing the Display Method and Order of Palettes ....... 26
Changing the Display Method (Dock/Float) of Palettes....... 26
Rearranging Palettes.............cccooiiiiiiiii 26

EXiting DPP ..o 27
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Viewing Images in the Main Window (Thumbnail Layout)

Images downloaded to your computer are displayed as a thumbnails list
in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.16) and display the image at large size.

Main window Toolbar

® On 32-bit OSs, up to only 1000 images can be displayed per

Check marks (p.31, p.32) Forward/Reverse folder. Starting with the 1001st image, images are handled in the
Ratings (p.31, p.32) Rotate image same way as non-supported images. Try to maintain 1000 images
For information on icons displayed on the frame of a thumbnail, or less per folder.
see “Image Frame Information in the Main Window and Edit ) o )
@ If you double-click on the movie file, the movie playback

I Wi ” (p.135).
mage Window" (b ) application specified with the computer’s OS settings will start up

and play back the movie. In this case, edited movies will not be
played back. You can also change the movie playback
application to EOS MOVIE Utility with Preferences (p.127). For
detailed instructions on EOS MOVIE Utility, refer to the EOS
MOVIE Utility Instruction Manual.

When aspect ratio information is attached to an image shot with
any supported camera other than the EOS 5D Mark Il, the image
is displayed as a cropped image (p.66).

In the main window, in addition to this view (thumbnail layout),
you can select multi-layout. Multi-layout allows you to check the
image in detail (p.18).
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Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu P desired item.

Open preview screen Ctrl+0O

¥ Thumbnail control panel  Ctrl+Alt+N

Pin Alt+O

Apply display filter
Sort »
v | Group RAW and JPG versions

Hide file name
+ | Default
With shooting info
Size 1 (84x84) Ctrl+1
Size 2 (126x126) Ctrl+2
+| Size 3 (168x168) Ctrl+3
Size 4 (252x252) Ctrl+4
Size 5 (384x384) Ctrl+5
Size 6 (512x512) i+ 6
( AF paints Ctrl+)

The display changes to the selected item.
To display thumbnails with shooting information attached, select
the [Tools] menu P [Settings for thumbnails with shooting info].

R
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Using the Thumbnails Control Panel

The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions

(1)
(2)
(©)
(4)
®)
(6)

3) 4(G) 6 ) ©)

Olte = lCl Change the size of thumbnails
uDispIay thumbnails without file names
EDispIay standard thumbnails

- Display thumbnails with information

Select information to display for thumbnails

Display a RAW image and JPEG image as a single image
Display a RAW image and JPEG image that were shot together
as a single image. When this setting is specified, viewing and
editing of images are as follows.

Image displayed: Only the RAW image is displayed in all
windows.

Edited image: The content which has been edited with any of
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following
functions, the adjustments will be applied to both the RAW
image and the JPEG image.

* Deleting an image (p.37)

* Moving or copying an image (p.37)

» Checkmarking (p.31 to p.32)

* Rating (p.31 to p.32)

* Rotating an image (p.11)

(7) ESeIect all thumbnails
(8)

Cancel all thumbnail selections

The thumbnails control panel is displayed in the main window by
default. If it is not displayed, such as when screen settings have
been changed, you can display it by selecting [Thumbnail control
panel] in the [Thumbnails] menu.

In multi-layout (vertical thumbnails, p.18), only the thumbnail view
settings (Default thumbnail display/Show thumbnails without file
names) are possible.
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Using the Thumbnail Display Filter/Sort

Function

This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

Click the [ )] button at the bottom of the main
window.

el | H- Filter  Off

Y GO E

The [Filter/Sort] palette is displayed.

Specify settings.
Filter/Sort

Filter Off
B Areply to all folders

Check mark
1 3 4 1] Mg
Clear all

Rating

CR MO tFd
TIFF

Clear all

File name* -

Ascending Jezcending

(1) Thumbnail display filter on/off
By setting to [On], only thumbnails matching the filtering option set
with (2) the filtering options menu are displayed.

(2) Filtering options menu
Select a filtering option for the thumbnail display filter.

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a
temporarily displayed after the option name.

ke

is

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.

Click the [] button again to hide the [Filter/Sort] palette.

When [Apply to all folders] is checkmarked with the thumbnail display
filter/sort function, filter settings will be kept and applied when you
switch to a different folder or the next time DPP is started up. When it
is not checkmarked, filter settings automatically change to [Off] when
you switch to a different folder or the next time DPP is started up.

 E———
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Displaying the Histogram Palette

The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu » [Histogram palette].
The histogram palette appears.

Histograrm

You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]

You can click the [] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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Enlarging and Viewing an Image in the Preview Window

Double-click

The preview window appears.

Up to 36 windows can be displayed at the same time for the
preview window.

((32bit] On 32-bit OSs, up to 4 windows can be displayed at the
same time.)

Preview window '

Tool palette

Click the [Ed] in the upper right of the preview window to close
the preview window.

@ By selecting the [Preview] menu P [AF points] in the preview
window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.84), images for which you selected an
effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or
chromatic aberration correction.

Introduction

M —

Contents

N —

Downloading
Images

Sorting
Images

N ———

Editing
Images
Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

|

Specifying
Preferences

|

Reference/
Index




Enlarging and Viewing a Specific Area

Click the area you want to enlarge.

The area you clicked is enlarged to 100% (actual pixel size).
Click again to revert to the full view.
To change the display area drag on the image.

5\@/5 To display an image in an enlargement ratio other than 100%

Select any enlargement ratio from the [Preview] menu.

@ While in the preview window, you can select the [Preview] menu »
[Preview control panel] to use various preview functions. For details,
see “Checking an Image Using the Preview Control Panel” (p.19).

Displaying the Navigator Palette

The navigator palette shows the enlargement area of a selected image.

Select the [View] menu » [Navigator palette].
The navigator palette appears.

Mavigator

1 T

When an image is enlarged in the preview or other window, the
enlargement display area is indicated in the navigator palette.
The area to be enlarged can be changed by dragging the
enlargement display area on the image.

Mavigator

r

Change the enlargement
display area by dragging

5 a
N
L T

o il |

You can click the [[E]] button at the bottom right of the main
window to show/hide the [Navigator] palette.
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Checking the Image in Detail

Displaying the Main Window (Multi-layout)

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).

The main window (multi-layout) appears.

In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.
Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the

image again to revert to full display.

Main Window (thumbnail layout)

Layout change button

L

Horizontal thumbnails

Vertical thumbnails

Multi-layout (horizontal thumbnails)

Preview
display area

Thumbnail
display area
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Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail.

You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [[#]] button and [] button are selected.

Changing the Magnification

200% ~ |%) |-B Y Y Y |E| B v dm v OJ A v

Display the image at actual pixel size (100%).

Click the [[§ ] button to display the image at the set
magnification displayed. If the [[EJIE]] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.

*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.

K1 200% ~ |::_ -B] v 1 " |E| m - n:u:n:n - OJ - ﬂ -

Select an image and click the [[iE]] button.

. gl | B | |t

Pinned (fixed) image

The window divides into left and right, and the selected image is
pinned.

When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.

After pinning an image, you can click the [] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time

x1 200% ~ |%) |-B Y Y Y |E| B v dm v OJ A v

Select multiple images, and click the [[&]] button.

The selected image is displayed.
You can display up to 8 images.

® On 32-bit OSs, this function is not available.
(The [[[&@)] button is not displayed.)

Displaying Grid Lines

x| 200% v |%) |-B Y Y Y |E| B - n:u:n:u - OJ v -

Click the [[§] button beside the [[E]] button, and set
the spacing between grid lines on the menu that
appears.

To set the spacing, enter values (8 to 256, in pixels), or move the
slider.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[]]] button.
The image with grid lines is displayed.

Displaying AF Points

%1 200% ~ |%) |-E] v ‘F ‘F |E| BH v gm v OJ - ﬂ A

Click the [[§] button beside the [[E]] button, and
select the item to display on the image on the menu
that appears.

Select [Show only AF points in focus] or [Show all AF points].
After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[]] button.

An image with the AF points selected in step 1 is displayed.

@ AF points are not displayed for images whose image size has been

changed and then been converted and saved (p.84), images for
which you selected an effect other than [Shot settings] as correction
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for
distortion correction or chromatic aberration correction.
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Displaying Areas Beyond the Set Range with
Warning Indicators (Highlight/Shadow
Warning)

You can set up warning indicators for both highlighted and shadowed
parts, which is effective for checking the clipped highlights and shadows
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted
part in red and the shadowed part in blue.

1 200% > © @ [F-[E-ME-0 =- &~ %G- H-

Click the [[]]1 button beside the [EF]]] button, and
specify settings on the menu that appears.

Highlight/shadow warning display settin... n

Show shadow warnings
Threshold{0-64) 32
Warning color -
Show highlight warnings
Threshald(192-255) 254
Warning color -

Cloge

Checkmark the [Show highlight warnings] and [Show shadow
warnings] checkboxes and enter the warning values.

You can also select different warning colors from the dialog that
appears when you click the [[ .. ]] button.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[[F]] button.

On the opened image, if there is an area that exceeds the value
entered in step 1, the highlighted part of that area is displayed in
red and the shadowed part is displayed in blue. If you selected
different warning colors, the parts are displayed in the specified

colors.

x1 200%+ O @

[ [ - (2~ () BB~

Comparing Pre- and Post-Editing Images
(Single-Image Display)

n:u:n:n v Oj -

H -

Select an image that is being edited and click the

[[iE] button.

By clicking the button, the display switches between the image

before editing and the current image (being edited).
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Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)
You can display before and after versions of an adjusted image in the
same window and check the adjustment results.

This function allows you to adjust an image while comparing the original
image and image being edited.

x| 200% v |;) |-!—-) ""Y |E| B - n:u:n:u - OJ v -

Select an image that is being edited and click the
[[Ed] button.

The image is displayed in two-screen display (Arrange vertically).

The image before editing is on the left, and the currently edited is
on the right.

Change the image display.

The display switches in the following order by clicking the [[E]]
button.

Arrange vertically (two-screen: left/right) = Arrange horizontally
(two-screen: top/bottom) — Split vertically (split-image: left/right)
- Split horizontally (split-image: top/bottom)

Displaying Image Properties
Display the shooting and recipe information for an image in the screen.
You can select items to be displayed.

& 0g- H-

x1 200~ @ @ [F~~[1~ M =~

Click the [[]] button beside the [[[Z]] button.
The [Preview properties display settings] window appears.

Specify display settings.

Preview Properties Display Settings H

(®) Show recipe details

() Show shooting info
Recipe display settings | Shooting info display settings

Brightness adjustment
‘White balance
Picture Style

Colar adjustment

Lenz carrection

[] Dual Pizel Raw Optimizer
Sharpness Croppine and rotation
futo Lighting Optimizer Fotate left # Rotate right
RGE tone curves Stamp

Moize reduction Color zpace

[v]

Select all Clear all

Cloze

To display recipe contents, select [Show recipe details] and
checkmark items you want to display in the [Recipe display
settings] tab sheet.

To display shooting information, select [Show shooting info] and
checkmark items you want to display in the [Shooting info display
settings] tab sheet.

After specifying settings, click the [Close] button.
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Select an image and click the [[[i]] button.

The image and properties selected in step 2 are displayed in the
screen.

If the recipe contents of an image being edited are displayed in
before/after comparison (two-screen display/split-image display),
edited items are displayed in red.

@ All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.

Checking an Image in Multi-Function Preview

The preview window shows the coordinates of the mouse cursor and the
work color space. By switching to multi-function preview, you can also
check image details in the same way as the main window (multi-layout).

Select the [Tools] menu » [Preview screen display
settings], and then [Multi-function preview] from the
dialog that appears.

After selecting, click the [Close] button.

Open the preview window (p.16).

A multi-function preview with various functions at the bottom of
the screen is displayed.

® Digital Photo Professional 4 - [IMG_0001.CR2]

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

x1 2000~ © ® [M-[A-[ME- & =8~ &% - %~

NI BYAYE e e e s s WD

For how to use the displayed functions, see “Viewing an Image in
the Main Window (Thumbnail Layout)” (p.11) and “Checking an
Image Using the Preview Control Panel” (p.19 to p.23).
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Checking an Image in Second Windows

Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,
etc.

Select an image, and then select [Show second
screen] from the menu that appears when you right-
click with the mouse.

fessional 4 - [IMG_0001.CR2]

0 TiY Tl

o il | B I

A second window is displayed.

To display an additional second window, repeat the operation.
You can change the size of second windows as desired.
Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.

When you magnify an image in the second window, the right-
clicked position on the image will be the center for the
magnification.

® On 32-bit OSs, second windows cannot be displayed.
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Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [[J"l]] for a panel to open or close.

Example: main window (thumbnail layout)

When a panel is closed, you can point to [[JJl]] with the mouse
to temporarily open the panel.
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Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
A docked palette is then displayed floating, and a floating palette
is then displayed docked.
To revert to the original display method, repeat the same
operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.

The order of the palettes is changed.
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Exiting DPP

In the main window, select the [File] menu P [Exit].
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Downloading
Images

Close window Ctrl+W

Save Ctrl+S

Save As... Ctrl+5Shift+5

Convert and save... Ctrl+D

Batch process... Ctrl+B

Print... Ctrl+P

Print with detailed setting.. Ctri+Alt+P

Plug-in printing

Add to collection Ctrl+G

Remove from collection  Ctrl+Shift+G

Clear collection

Select collection

Delete collection

Bookmark

Remove bookmark

Maove to Recycle Bin Del
R Alt+F4

DPP exits.

@ A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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3 Organizing and Sorting Images

Efficiently Checking/Sorting Images.............ccccc....... 29
Sorting IMages ........uvveeeeeeiiieiiiee e, 31
Attaching Check Marks............ccceeeeeeeeeieieeiicnnneee, 31
Setting Ratings ........ccccoiiiiii 31
Sorting Images in the Main Window ..............cccccce..... 32
Attaching Check Marks in the Main Window .......... 32
Setting Ratings in the Main Window....................... 32
Arranging Images in the Main Window....................... 33
Arranging by TYPE ......oooiiiiiiiieieeeeee e 33
Arranging Freely ..o 34
Displaying a RAW Image and JPEG Image as a Single
0 F= o [ TSRS 34
Checking Image Information..................evviiiiiiiiiinnnnnnes 35
Organizing IMages .......ccceeveeeeeeeeeeeeeeceee e 37
Deleting an Unwanted Image ............coooeevviiiiiieeennnnns 37
MOVING IMAgES ......eveiiieiiiiiiiii e 37
Moving Images in Folders ..........cccccccoeoiiiiiiiinieennnn... 38
Registering Frequent-Use Folders (Bookmark
Registration) .........cccccooiiiiiiiiie e 38
Deleting Bookmarks .............coooociiiiiiieeiieeeeeeeeeee, 38
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.

Select multiple images to check in the main window.

Display the quick check window.
Click the [Quick check] button.

& Digital Photo Professional 4 - [Folder: C:\Users\xoo\Desktop\xo

File Edit View Thumbnails Preview Label Adjustment Tools Windc

Edit Image Remaote Shooting

The quick check window appears.

Click the [[E] or [[] button to switch between
images to be checked.
Quick check window

 Digital Photo Professinal 4 - [Folder: C:AUsers\xoo\ Desktopioaa 03]

All the images displayed in the main window can be checked in
the quick check window.

If you click the [[Bll] button, the first image is displayed, and if you
click the [[g]] button, the last image is displayed.

Click the [[B]] button to return to the main window.
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Click the area you want to enlarge.

The area you clicked is displayed at 100% (actual pixel size).
To change the display position, drag on the image.

If you click the [ |E2] button, you can display the image at 50%.
Click again to revert to the full view.

To exit, click the [[E}] button.

In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [ﬂ] button beside the

] button on the screen, select a magnification from the menu
that appears, and click the [close] button.

If you click the [ [EZl] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.84), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

Ay

-@> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switching between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switching between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operations using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[El] to [E]-

Thurmbnail position

o Bottom

P L=it
v"1 v"2 \/3 v"4 \.—"5 . Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

@ The values of check marks attached to images in versions before
DPP 4 are not maintained.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings
Display the image you want to rate, and then click
any one of the [¢].

O Bottom ® L=it
\/1 \/2 \f3 \/4 \/5

Click

+ < 2/16

. AF points

Info

The rating is set and an icon corresponding to the selected [{%7]
appears in the upper left of the window.

(Window shown with a rating of three [%])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

To cancel the rating, click the same [¢%] as when the setting was
made on the right of the window.

@ As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks

or setting ratings (indicated with [5%] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [El] to [E]-

Select

Click

The selected check mark appears in the upper left of the image
frame.

Check mark

Click the check mark again to remove the check marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [¢].

o il | B e il . - Select

Click (changes to [%¢] after clicking [ @])
The rating is set and an icon corresponding to the selected [§%z]

appears in the image frame.
(Sample window shown with a rating of three [$%] as an example)

Rating icon

O —8 @ T
Q@ & m = H

R L. > > T B E 5,

To cancel the rating, click the same [$%] as when the setting was
made.

Set [Reject] with the [Label] menu or the quick check window
(p-29).

 E———

Introduction

M —

Contents

N —

Downloading
Images

——

Viewing
Images

Sorfing
Images

Editing
Images
Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

|

Specifying
Preferences

|

Reference/
Index




A
~

:@/E To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

@ The [Label] menu can also be used to attach check marks and set
ratings.

You can display and change the rating settings set in DPP with

other EOS software and with any supported EOS camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D Mark

IV, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 5D Mark I, EOS 50D,

EOS 550D, EOS 500D, EOS 450D, and EOS 1000D.

« EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

» With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark IV, EOS-1Ds Mark I,
EOS-1D Mark Ill, EOS 5D Mark Il, EOS 50D, EOS 550D, EOS
500D, EOS 450D, and EOS 1000D:

Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change in DPP the rating

settings set for images on any supported EOS camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D

Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS 5D Mark I,

EOS 50D, EOS 550D, EOS 500D, EOS 450D, and EOS 1000D.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [Thumbnails] menu » [Sort] » desired item.

The images are arranged in the order according to the selected

item.

Sort item Description
File name: ascending Images are sorted by file name in alphanumeric
order order (0to 9 » Ato 2).
Extension: ascending Images are sorted in the following order: RAW
order images - JPEG images - TIFF images —

MOV movies = MP4 movies.

Shooting Date/Time:
ascending order

Images are sorted by shooting date and time
from the earliest.

Check mark:
ascending order

Rating: ascending
order

Images with check marks take priority and are
sorted in number order.

Sorted in order of fewest [$%¢].

Camera Model Name: Sorted in order of least digit used in the camera
ascending order model name. (Ex.: EOS-1D X - EOS 6D)

Lens: ascending order Sorted in order of shooting lens with shortest
focal length.

ISO speed: ascending Sorted in order of lowest speed.
order

Shutter speed:
ascending order

Aperture value:
ascending order

Sorted in order of fastest shutter speed.

Sorted in order of lowest aperture value.

Sorted in order of shooting lens with shortest
set focal length.

Focal length:
ascending order

* Descending order sorts all items in the reverse of ascending order.
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Arranging Freely

Drag and drop the image to the desired location.

oL TTL T

o | B s

The image moves to the desired location.

You can also select multiple images (p.33) and move them.

The order of rearranged images is temporarily registered as
[Custom] in [Sort] of thumbnails control area and maintained until
you exit DPP or select another folder in the folder area.

Select the [Thumbnails] menu » [Sort] » [File name] and [Ascending]
to revert to the order before the images were rearranged.

-:\@/E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View Settings] tab sheet in [Preferences] to maintain
the order of images without changing the image file names (p.131).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.119).

Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu » [Group RAW and
JPG versions].
The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(R+J)] mark (p.135).

'? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

-:@/3 When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.37)

» Moving or copying an image (p.37)

» Checkmarking (p.31, p.32)

* Rating (p.31, p.32)

* Rotating an image (p.11)
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Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[R+D] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

@ If you cancel selection of [Group RAW and JPG versions], the RAW
image and JPEG image are displayed as separate images.

Checking Image Information

Select the image for which you want to check the
image information.

Select the [View] menu » [Info].

The image information window appears.

Image information window

[Exif Information]
tab sheet

[XMP/IPTC Information]

tab sheet

Select a tab sheet and check information.

[Recipes]
tab sheet

IMG_0001.CR2 x|

[ Exif Trfstmation | XMP/IPTC Information | Recipes

Ttem Value ~
File Name IMG_0001 GR2

File Size 245MB

Gamera Mode| Ganon EOS 340K

Firmware Firmware Version XXX
Shooting Date/Time  XXKKARAKK KARKH
Owner's Name

Shonting Mode AperturePriority AE
Te(Shutter Speed) 1440

Avlfiperture Value) 5

Metering Mode Evaluative Metering

Exposure Compensa.. 0

150 Speed 3200
#uta 150 Speed oN

Lens EF 17-40mm £/4L USM
Focal Length 340mm

Image Size HHHR R RRKH

Aspect ratio 32

Image Quality RAW

Flash off

FE lock OFF

White Balance Mode  Auto

AF Mode Manual focusing

Picture Style Landscape

Sharpness ] v
< >

IMG_0001.CR2 x|

Exif Tnformation || #MP/AP 10 Information || Recipes

[Deseription
[Document Title]
RRRHOHHDH

[Creatar]
OO0

[Creator's job Title]
SRR

[Description]
KKK

[Description Unkiter]
SRR

[Keywards]
SOROGHR04

[Copyrieht Status]
HRRHHHHO

[Copyright Matice]
RRRHOHHDH

[Gopyright info URL]
RO

IMG_0001.CR2 | x |
Exit Information | ¥MP/IPTG Information | Fecipes |
Hem Walue ~
Brightness adjustment 000
white balance (Auta)
Picture Style (Landscape)
Cantrast
Shadow oo
Highlight 0
Caolor tane oo
Color saturation oo
Linear off
Black point 000
Midpoint 000
Wihite point 000
Sharpness Strength : 4.0 Finer
Auto Liehting Optimizer Standard
RGE tone curves Original
Reduce luminance noise an
Reduce chrominance noise 110
Color adjustment Off
Hue oo
Saturation +1000
Off
Orange Off
Yellow off
Green Off
Aqua off
Blue Off
Purple off
Magenta Off
Lens correction On
Digital Lens Optimizer Off
Peripheral illumination 400 w
Chramatic ahereationn nnn RN AND
<
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Shooting information is displayed in the [Exif Information] tab
sheet, while IPTC* information appended to the image after
shooting is displayed in the [XMP/IPTC Information] tab sheet.
IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [XMP/
IPTC Information] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Exif Information] tab sheet will vary
depending on the camera model.

Recipe contents applied to an image are displayed in the
[Recipes] tab sheet.

A/
~ -

-Q= Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the thumbnail with shooting information
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnails] menu » [With shooting info] (p.12).
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Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image
Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Move to Recycle Bin].

Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+S
Convert and save... Ctrl+D
Batch process... Ctrl+B
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection  Ctrl+Shift+G
Clear collection
Select collection 3
Delete collection 3
Bookmark
Remove bookmark

[Move to Recycle Bin Del ]
Exit Alt+F4

The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.

File Edit v Thumbnails i Labe Adjus Window Help ]

I

il | B W e

Downloads
i Music
E Pictures

DATA (E) + I /5_0001.CR2
- REMOVABLE DISK (1)
£ BD-RE DRIVE ()
-== REMOVABLE DISK (K}
- REMOVABLE DISK (L)
.= REMOVABLE DISK (M)

N Network
1 i} Holiday
. Travel

The images are moved or copied to the destination flder.

R
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Edit Image Cluick Check

Folder Bookmark

L Tt 1

| r Videos
05 (C)

- DATAZ (D)

|- = DATA (E)

-— REMOVABLE [ ISK (1)

£ BD-RE DRIVE ()
REMOVABLE L ISK (K)
REMOVABLE L ISK (L)
REMOVABLE CISK (M)

IMG_0001.CR2

L

The folders are moved or copied to the destination foIer.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

Select the folder for which a bookmark is to be
registered.

File /  Thumbnails Label Adjustment Window Help f

IMG_0001.CR2

—= REMOVABLE DISK (k)
&8 BD-RE DRIVE ()
- REMOVABLE DISK (K
== REMOVABLE DISK (L)
REMOVABLE DISK (M)
Libraries

o T
L) |HSiiaay

Select

Select the [File] menu » [Bookmark].
The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu » [Remove bookmark].
The selected folder is deleted from bookmarks.
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4 Editing Images

RAW IMages ....c.uiiiieiieeeee e
RAW IMages......coooiiiiiiiiii e
RAW Development ..........cccoooviiiiiiiiiiiiiiieeeeeeeen
When RAW Development is to be Done....................
Advantages of a RAW Image .............cevvvvvieiiiiinnnnnnnes

Editing JPEG and TIFF Images ............ccceevveeeennnnee
Tool Palettes ...

Editing with the Basic Adjustment Tool

Palette ...,
Adjusting Brightness ...,
Changing the Picture Style ...........cccoooeiiiiiiiieeenn,

Using a Picture Style File ...........ccccooveevenn...
Adjusting Color Tone by Changing White Balance....
Adjusting Color Tone Using Click White Balance......
XD Adjusting White Balance with Color
TempPerature ..........coevee i
Tuning White Balance...........cccccceeeeuveeenne...
Adjusting Contrast ...........ooeeviiiiiiiiiiiiiiiiis
Adjusting Brightness of Shadows/
HIghlights ...
Changing Color Tone and Color Saturation...............
Adjusting Monochrome............cooieiiiiiiiiieeiiiinn.

T Adjusting Dynamic Range...........cccoevee......
Adjusting Gradation and Luminance Automatically ...
Using the Auto Lighting Optimizer............................
Adjusting Image Sharpness.........ccccccceeeviieiiiiiininnnnnn..

Detailed Setting of Image Sharpness ....................

44
44
45

47
47
48

49

49
50

50
51
51

52
53
o4
55
56

Editing with the Tone Adjustment Tool

Palette ... 57
Adjusting Brightness and Contrast...................co.o... 57
Adjusting Color Tone Using Click White Balance....... 58
A Adjusting Tone CUrve .........occveeeceeeeeveeenee. 59

Example of a Tone Curve Operation...................... 60
A Adjusting Dynamic Range...........cccocccveenne.. 61
Using the Auto Lighting Optimizer...........cccccccooennee. 61

Editing with the Color Adjustment Tool

Palette ... 62
Editing with the Color Adjustment Tool
Palette ... 62

Adjusting a Specific Color Gamut........................... 62
Adjusting Hue and Saturation for an

Entire IMage .......ccvvvveeeeeiee e 63
Adjusting in Monochrome ............ccccceeeiiiiiinee e 63

Editing with the Detailed Adjustment

Tool Palette .......coooviiii 64
Reducing NOISE ..........cooeiiiiiiiiieeeeeeee e 64
Adjusting Image Sharpness.........ccccoceevviiiiiiiiiieeeeeeenn. 65

Editing with the Trimming/Angle

Adjustment Tool Palette ..., 66

Editing with the Lens Correction Tool Palette.......... 69
Correcting Lens Aberration............cccceeeeeeeeee e, 69
Making Corrections..........ccveevieiiiiiiiee e 70

Effects of Distortion Correction for Fisheye
LENSES ... 71
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Shooting Distance Information Slider ........................ 72
Correcting Multiple Images ata Time............cccccoe...... 73
Digital Lens Optimizer.........ccccccccooeeieiiiiiiiiieeieeeeeee 73
Using the Digital Lens Optimizer .............ccccooeeeeee. 74
Adjusting Image Sharpness..........ccccvvvvvvvvneeinnninnnnnnnns 76
Editing with the Dust Delete/Copy Stamp
Tool Palette ........cooo i 77
Performing Automatic Dust Erasure Processing ....... 144
Automatic Dust Erasure Processing in the Main
WINAOW ..ot 78
Manually Erasing Dust (Repair Function).................. 79
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ... 81
Setting Work Color Space.......ccccccceeevvvveeeeeeiiiin. 82
Using the Soft-Proof Colors Function....................... 83
(eeemirr ) Saving Editing Results.........cccooooeeeen. 84
Saving Editing Contents to an Image ........................ 84
Saving as a separate image ........cccccceeeeveeeiniinnnnnnnnn. 84
Re-Editing an Image..............ccoeiiiiins 86

Utilizing Adjustment Contents (Recipe).... 87
Copying a Recipe and Applying to Another Image.... 88

Savinga Recipeas aFile......cccccooiiiiiiiiiiii. 88
Loading and Applying Recipes.........cccccooiveeeeneennnnn. 89
(eeemier ) Adjusting by Comparing Multiple
IMAQGES ... 90
Editing Efficiently ............cccoooiiiii 91

Editing in the Edit Image Window............cccccvveeeeenn... 91
Changing the Thumbnail Display Position to
Horizontal ........cccoooiiiiiiiiii 92
Gathering and Editing Images in the Collection
WINAOW ....eeiiiiiiiiiiee et 93
Compositing Images............ccceeevvvvvviveeeeenen. 95
Compositing Methods.............oooiiiiiiiiii, 98
Creating HDR (High Dynamic Range)
IMAGES ... 99
Using the Dual Pixel RAW Optimizer-........ 102

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel

RAW Fil€ ..o, 102
Reposition the Viewpoint or Foreground Bokeh for
a More Pleasing Result ..., 103

Reduces the Appearance of Ghosting in Images..... 104

T Transferring a RAW Image to
PhotoShOp ..oveiie 106

Customizing the Main Window Toolbar .... 107

* Sections with and in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image

editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.
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RAW Images
RAW Images

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“‘development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.87).

iy

" RAW image

Contents adjusted using the tool

palettes can be handled
—1| individually as a recipe file

(extension “.dr4”) (p.87, p.88).

7

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.88), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.89). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.

» Tone Adjustment tool palette

* Color Adjustment tool palette

* Detailed Adjustment tool palette

» Trimming/Angle Adjustment tool palette

* Dust Delete/Copy Stamp tool palette

* Settings tool palette
Because adjustments made with these tool palettes (the recipe) only
change the image processing conditions, the “original image data itself’
remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.

Image processing conditions information

R — Contents adjusted using the tool
palettes can be handled
=—1 individually as a recipe file
(extension “.dr4”) (p.87, p.88).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.88), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.89). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.

R
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Tool Palettes

With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only
change the image processing conditions, the “original image data itself’
remains unaffected. As there is no image deterioration that normally
accompanies editing, you can readjust your image any number of times.
The various functions of the tool palettes are explained in more detail
under the respective topics.

Trimming/
Angle
Lens Adjustment
Correctiontool tool palette
palette
Basic Dust Delete/
Adjustment Copy Stamp
tool palette tool palette
Detailed Settings tool
Adjustment palette
tool palette
Tone Color
Adjustment Q?;JS;T;?{:
tool palette | e Uit Ot p

*

Pic: vle |4

Y (Standard - Erowse...

Gamma a ent Y

Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.44).

Tone Adjustment tool palette

Adjusts the tone curve and applies the Auto Lighting Optimizer (p.57).

Color Adjustment tool palette

Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.62).

Detailed Adjustment tool palette

Reduces noise and adjusts the image sharpness (p.64).

Trimming/Angle Adjustment tool palette
Crops an image and adjusts the image angle (p.66).

Lens Correction tool palette
Corrects lens aberration in the image (p.69) and applies the Digital
Lens Optimizer (p.74).

Dust Delete/Copy Stamp tool palette

Erases dust from an image and corrects image by copying sections
of the image (p.77).

Settings tool palette

Configures the work color space (p.82).

5@/5 Using the different tool palettes

We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.57), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.64) and lens aberration correction (p.70), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.64) and Lens Correction tool palette (p.69).
You can click the [] button at the bottom right of the main window
to show/hide [Tool palette].
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JPEG/TIFF

Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW
images. With this tool palette, you can adjust the image brightness, set
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.

Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness.

Select an image in the main window, etc.

Display the Basic Adjustment tool palette.

Tool paletts

Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Tool palette

Reverts the image to
the original settings

Enter a numerical
value

Drag the slider left or right

@ The adjustment range is —3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Changing the Picture Style

If the image looks different from what you visualized at the time of
shooting, you can get it closer to what you expected by changing the
Picture Style. Even if you have saved the image (p.84) with
[Monochrome] (p.51) selected, you can still change to another Picture
Style at any point by simply selecting a Picture Style other than
[Monochromel].

Ficture Style
By (Standard) o
Gamma adjustment ¥

B Linsar

0 50 40 20 00 20 40

Reverts the image to
the original settings

Select

Move midpoint to match

Picture Style

Description

The Picture Style set with the camera when the
image was shot.

When a mode in the Creative Zone is selected on the
camera, the Picture Style set is displayed in ().

Introduction
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Downloading

B0 When a mode in the Basic Zone is selected on the Images
camera, [Shot settings] is displayed in (), and image
characteristics that are according to the selected Viewing
shooting mode are applied. Images
Standard The image Iqoks VI-VId.. . .
Generally, this setting is suitable for most images. Sorting
The color tone will be adjusted to suit the scene. Images
The colors will look vivid. Especially the colors of
Auto . . L
blue skies, greenery, and sunsets will be vivid in a Edifhg
shot of nature, outdoor, or sunset scenes. I#s
For nice skin tones.
, Effective for close-ups of women and children. By |
Portrait . . . Printing
changing the [Color tone], you can adjust the skin Images
tone (p.51).
For vivid blues and greens. Processing
Landscape Effective for making images of landscapes Large Numbers
impressive. AR
Suited for detailed outline and fine texture Remot ‘
Fine Detail description of the subject. The colors will be slightly Sh%rggneg
vivid.
For natural colors and subdued images. -
. . . Specifying
Neutral Effective for base images which are to undergo BEAF. oo leee
adjustment.
When the subject is photographed under a color
temperature of 5200K, the color is adjusted Relfﬁazr)n(cel
Faithful colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment. @ @
For black and white images.
Monochrome  You can also adjust with [Filter effect] or [Toning

effect] (p.51).
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Picture Style

(Picture Style file
registered in the

camera)

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

[Picture Style file
applied in DPP]

The name of the Picture Style file applied in DPP is
displayed in [].

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.

[Auto] is not applied to images shot with the EOS-1D Mark 1V,
EOS-1Ds Mark Ill, EOS-1D Mark 1ll, EOS 5D Mark Il, EOS 7D,
EOS 60D/EOS 60Da, EOS 50D, EOS 550D, EOS 500D, EOS
450D, EOS 1000D, EOS 1100D, PowerShot G3 X, PowerShot
G1 X Mark Il, PowerShot G7 X, PowerShot G9 X, PowerShot
SX60 HS, PowerShot G5 X, PowerShot G16, PowerShot S120,
or PowerShot G1 X. When changing the Picture Style with
several images selected, although you can select [Auto] if images
shot with any supported camera other than the above are
included, [Auto] will not be applied to the images shot with the
above cameras.

You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark Il, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S120, and
PowerShot G1 X.

You cannot select [Auto] with multiple-exposure RAW images
created with the camera.
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Using a Picture Style File

A Picture Style file is a Picture Style extension file.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon website effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Click the [Browse] button in the [Picture Style] panel.

Gamma adjustment LA

B Ui

G0 =40 =20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.
To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Tool palette

‘White balance adjustment

Reverts the image to

* the original settings

P 1 2 ]

o ]

Select

i3 () is the white balance set on the camera when the image was shot.

* When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ().

 When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.48).

@5 Tune with color tone

To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.51) for tuning towards your expectations.

You cannot register the adjustment results as personal white
balance (p.114) when you have selected [ f%( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Tool palette

Click

The coordinates of the cursor position and

the RGB values (8-bit conversion) Reverts the

image to the
original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[El] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.
Set the color temperature.

Tool pa lette

White balance adjustment

2t

—
Caolor temperature -

s

Displays the value of
the setting

Drag the slider left or right

@ The adjustment range is 2000 to 10000K (in 10K increments).

Tuning White Balance

This is a function that makes fine adjustments to the white balance.

Using this function, you can achieve the same effects as third-party

color temperature conversion filters and color correction filters. The
adjustable range is £10 steps. This function is aimed particularly at high-
end users who are familiar with the roles and effects of color
temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

Fine-tune

’ E
o)

Enter the values to set

Drag Drag the sliders left
or right

B stands for blue, A for amber, M for magenta and G for green.

The color is adjusted towards the color to which the point moves.

You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.

® To register the adjustment outcomes as a personal white balance
(p.114), select a setting other than [ ( )] from the [White
balance adjustment] list box before tuning the white balance. If
you selected [|f4( )] from the list box and tuned the white
balance, you cannot then register the outcomes as a personal
white balance.
You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

@ The adjustable range is 0 to £10 (in 0.1-stop increments when
entering a value).
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Reverts the image to
the original settings

Picture Style

Yy (Standard) -

Gamma adjustment

Drag the slider left or
right (9 steps)

Enter a setting (in
0.1-stop increments)

Adjusting Brightness of Shadows/Highlights
You can adjust the brightness of shadows and highlights in an image.

By adjusting only shadows or highlights in an image, you can reduce the
effects of clipping in shadows and highlights.
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Changing Color Tone and Color Saturation

Tone and overall color saturation can be adjusted.
If Picture Style (p.45) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

Reverts the image to
the original settings

Drag the sliders left or
right

or tone N— + ju—

saturation — + fr—

Enter a setting (in
0.1-stop increments)

Color tone: Move the slider to the right to make tones
more yellowish, and to the left to make tones
more reddish.

Color saturation: Adjusts the overall color intensity for the
image. Move the slider to the right for more
intense colors, and to the left for less intense
colors.

@ The adjustment range is —4 to +4.

Adjusting Monochrome

When the Picture Style (p.45) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering, or with a look
of monotone color photograph.

Select [Monochrome] in the [Picture Style] list box.

Picture Style [~ Reverts the image to

SR the orginal setings

Gamma adjustment A

B Linear
5.0 =40 -20 00 20 40
v

Displays the values of
the settings

R
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Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.

Filter Example of effect
None General monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

ALy

=@ Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider to the right.

Adjusting Dynamic Range
Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Y (Standard) -

Move downwards
Output white points

Move to the left or right
Input white points

; T Move to the left or right
/ Mid (medium tone) point
e — : : : -+— Move upwards

an |3 L 0.00 Output black points

I{ B ]

Ak

You can also adjust
the dynamic range by

00 "
entering values

0o
0o
0o
0.0

AR ArRArEAERAL

Move to the left or right
Input black points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input
black points.
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A/

=)< [Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.

@ [Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.54) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.

White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
Settings that are reset and those that are not with this adjustment
are as follows.

Settings that are reset

- Auto Lighting Optimizer

- [Contrast] in the [Advanced] panel

Settings that are not reset

- Brightness adjustment

- White balance adjustment

- Linear*

* White points and black points are automatically adjusted.

@ An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to
RAW images.

* ALO stands for Auto Lighting Optimizer.

Checkmark the [Auto Lighting Optimizer] checkbox.

&uto Lighting Optimizer

Checkmark

Standard Strong

For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the setting according to your preferences.
Auto Lighting Optimizer

Select from three
levels: Low/Standard/
Strong

Auto correction is applied to the image to match the setting.
For the image shot with the camera’s Auto Lighting Optimizer
function, the setting at the time of shooting is applied as the
default value.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

—

Loy Standard

@ When [Highlight tone priority] is set to [Enable] on any supported
EOS camera other than the EOS-1D Mark IV, EOS 5D Mark Il, or
EOS 550D, the Auto Lighting Optimizer cannot be used for RAW
images.
You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created with the camera.
When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

@ [Unsharp mask] cannot be used with images other than RAW
images.

Select [Sharpness] from the list box and adjust the
setting.

Ficture Style Reverts the image to

Tl the original settings

Gamma adjustment

B Linear

80 -60 -40 -20 00 20 40

Select [Sharpness]

Enter a setting (in
0.1-stop increments)

Drag the slider left or right

The adjustment range is 0 to 10.
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Detailed Setting of Image Sharpness
Select [Unsharp mask] from the list box and adjust
the setting.

Pictu ¢le I"‘\

ﬂ (Standard) o Browsze. .

Gamma adjustment %A

B Lincar

10 50 40 20 00 20 40

Select [Unsharp mask]

Fineness Enter a setting (in
Threshold 0.1-stop increments)
Drag the slider left
or right

@ Adjust image sharpness with the window view set to [400%], [200%]
or [100%)]. If the view is set to [Fit to window] (full view), you may not
be able to correctly check the adjustment results.

R
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JPEG/TIFF

Editing with the Tone Adjustment Tool Palette

With the Tone Adjustment tool palette, you can adjust images with the
same functions as general image editing software.

Select an image in the main window, etc.

Display the Tone Adjustment tool palette.

Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted. Since the
adjustment range is broader than the same functions in the Basic

Adjustment tool palette, the image color may be saturated, or the image

quality may deteriorate if you adjust too much. Be especially careful

when adjusting.

Reverts the image to
the original settings

]

— Drag the sliders left or
right

—Enter a setting (in
0.1-stop increments)
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Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

Contrast: Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

@ The adjustment range is —100 to +100 (in 0.1-stop increments when
entering a value).

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[lE@] button.

] .9 A iz

Lztment | 4=,
® Lumirance R G B

Ciontrast
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Click on a point that is to be the standard for white.

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[El}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.

Adjusting Tone Curve

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.136).

Select the tone curve mode and interpolation
method.
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Make adjustments.

Tore curve adjustment

. Luminance R G B

. Straight

ra

=

'—‘r—

A

RGB: Adjusts RGB
in a batch

R, G, B: Adjusts
each channel

You can display pre-
and post-adjustment
histograms

Coordinates of [[]
(when several
coordinates are set,
coordinates of last-
set [[])

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[] is 8.

To delete a [[], either press the <Del> key or double-click on the [[1].

Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards
Output white points

=] (i) 71 ) F o
Tone curve adjustment |, Reverts the
Luminance R & B image to the
Straight original
settings
Move to the o — Move to the
right left
Input black Input white
points points
Input black Input white.
point numerical (& 0 2l | pointnumerical
value (RN S o value
Output black Output
pointnumerical [[Es. white point
value numerical
Ce CCNES| iy

Move upwards
Output black points

The horizontal axis shows the input level and the vertical axis shows
the output level.

@ The setting range of black points is 0 to 247 (in 1-stop increments
when entering a value).
The setting range of white points is 8 to 255 (in 1-stop increments
when entering a value).
You can display pre- and post-editing histograms (p.60).

Using the Auto Lighting Optimizer

For information on using the Auto Lighting Optimizer, see “Using the
Auto Lighting Optimizer” (p.54) in “Editing with the Basic Adjustment
Tool Palette”.
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JPEG/TIFF

Editing with the Color Adjustment Tool Palette

With the Color Adjustment tool palette, you can adjust the hue,
saturation and luminance in a specific color gamut for 8 color gamuts
(red, orange, yellow, green, aqua, blue, purple and magenta). You can
also adjust the hue and saturation for the entire image and tune
monochrome images.

Select an image in the main window, etc.

Display the Color Adjustment tool palette.

Editing with the Color Adjustment Tool Palette

Adjusting a Specific Color Gamut
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

H: Adjusts the hue.

S: Adjusts the saturation.

L: Adjusts the luminosity.

Revert all adjustments to
the original settings

Color adjustment

Hue

Saturation

Drag the sliders left
or right

Enter the values to set

Revert color gamut
adjustments to the
original settings

Orange

|4,

ellow

|4~

@ The adjustment ranges are as follows:

H: —20 to +20
S: —10to +10
L: —10to +10

R
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Adjusting Hue and Saturation for an Entire
Image
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

Hue: Move the slider to the right to make color tones more

yellowish, and to the left to make color tones more reddish.

Saturation: Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for
less intense colors.

Color adjustment

Revert all adjustments
Hue to the original settings

Enter the values to set

Saturation

— Drag the sliders left or
right

|

Orange

@ The adjustment range for hue is —30 to +30; and for saturation is 0
to 200.

Adjusting in Monochrome

Press the [Monochrome] button to set the 8 color gamuts to their least
saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.

Color adjustment

Hue

Saturation

LY

Oranege

I~

*re o

I~

——— [

Monochrome

Drag the sliders left or
right

Revert all adjustments
to the original settings

Enter the values to set

R
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JPEG/TIFF

Editing with the Detailed Adjustment Tool Palette

You can use the Detailed Adjustment tool palette to reduce the noise
that occurs in images shot at night or at high ISO settings. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that you can use the functions in this tool palette with
JPEG and TIFF images as well as RAW images.

Select an image in the main window, etc.

Display the Detailed Adjustment tool palette.

Tool palette

Reducing Noise

You can reduce noise that arises in images shot at night or with a high
ISO speed.
* NR stands for Noise Reduction.

Adjust an image.

Enlargement
display
position

Check window

Maize reduction

Reduce luminance peiss Drag the sliders
o
Reduce chroniimarce noise Enter a Setting (In
- - 0.1-stop increments)

You can set a noise reduction level from within a range of 0 to 20.

The larger the setting, the larger the noise reduction effect.
The noise reduction effect can also be checked in the check
window.
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Y
ZQ)= Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.

@ If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.55).
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JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before cropping.

Select the image to be cropped.
Display the Trimming/Angle Adjustment tool palette.

You cannot make adjustments with the Trimming/Angle
Adjustment tool palette in a window that only shows thumbnails.

Adjust the angle of the image as needed.

Trimming/angle adjustment window

Largest possible
trimming range

Drag (0.01-degree increments; adjustment range: —45 to +45
degrees)

Use the mouse (click A/V¥)to adjust the angle or directly enter
the adjustment angle (0.01-degree increments; adjustable
range: —45 to +45 degrees)

image.

If you have only adjusted the angle of the image, the image will
be cropped at the largest possible trimming range.

Select a ratio and drag the trimming range.

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

@ When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark I, the displayed
trimming range is based on the aspect ratio information.

Select a trimming ratio

Drag the trimming

Introduction

—_—

Contents

—_—

Downloading
Images

Viewing
Images

€

Sorting
Images

Editing
| s

—

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Specifying
Preferences

Reference/
Index

00

66




List of aspect ratios (width : height)

| Free - |

T e 00 OO0 D —

[=r]

1
16
Custam

[Free]:

You can crop an image to any size, regardless of
the selectable ratio.
[Custom]: You can crop an image at the specified ratio.

Return to the main window.
The trimming range frame is displayed in the cropped image
(p.135).
When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

? Cropped images

The trimmed range can be reverted to its original condition at

any time

A cropped image is displayed or printed as a cropped image.

However, since the image is not actually cropped, you can always

revert to the original image by clicking the [ [ lka3l] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.86).

Display of the cropped image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.135).

* Preview window:  The image is displayed in its cropped condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.

Printing a cropped image
You can print as a cropped image by printing it in DPP.

The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.84).

Images that have aspect ratio set will be displayed as cropped
images

When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
I, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EQOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.®

When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [ [ Ea3] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EOS 5DS R, EOS 5D Mark 1V,
EOS 5D Mark Ill, or EOS 7D Mark Il and [Add cropping information]
is set in Custom Functions, aspect ratio information is only set and
the image is not actually cropped, even for JPEG images.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration . .
correction functions and the Digital Lens Optimizer to correct lens Correctlng Lens Aberration
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Note that you can only correct aberration in RAW images which have
been shot with compatible lenses. JPEG or TIFF images cannot be

Select an image in the main window, etc. corrected.

Display the Lens Correction tool palette.

@ To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.

@ Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.75).
You can also correct RAW images taken with the compatible lens
even when the extender is attached.
You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.
The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.

Peripheral illumination

Chromatic aberration (color fringing which occurs in the periphery of
an image)

Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)

Distortions Diffraction

Select an image in the main window.

Display the Lens Correction tool palette and
checkmark the items to be corrected.

Enlargement display section

‘‘‘‘‘

The image is corrected and redisplayed.
In the main window, the [# 1] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.135).

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.

You can lessen the degree of correction by moving the slider to
the left.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.71).

For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
[Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera's
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.
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Introduction
Effects of Distortion Correction for Fisheye Emphasize Distance
This converts the image to an “equidistant projection” style image.
Lenses Content
This projection method preserves distance relationships. ontents
Shot settings Equidistant projection displays a distance in the same distance
By selecting this option, only the aberration corrections will be anywhere from the center to the periphery. In particular, when _
performed to correct the optical distortions. shooting a celestial body such as the celestial sphere, same heights D°‘|”n']‘;°ae°s"“9
above the horizon(declination) are captured at the same heights. This g

method is therefore used in such photography as celestial

photography (star maps, solar path diagrams, etc.). Viewing
Images
Sorting
Images
Editing
| S
Emphasize Linearity Printing
This converts the image to a “central projection” style image. This Images
projection method is employed for general lenses. . .
Since central projection displays straight lines as straight lines, a Empha5|ze Penphery _ L _ Processing
wide-view panoramic image can be obtained by selecting this option. This converts the image to a "stereographic projection” style image. :;fa'gAeanT:;;:
However, the periphery is stretched, resulting in decreased resolution. This projection method emphasizes the periphery.
Stereographic projection allows position relationships on a spherical
' surface, such as N, S, E, W on a map, to be displayed correctly. It is Remote
A4 therefore used for world maps and monitoring cameras. Shooting
By selecting this option, the periphery is stretched and may result in
decreased resolution. Specifying
: Preferences
B O <25
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Emphasize Center

This converts the image to an “orthographic projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

@When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection
method. However, the conversion does not really apply a change of
projection method in a strict sense.

Accordingly, be aware that they are not suited for scientific or other
such purposes.

Shooting Distance Information Slider

When correcting RAW images and if shooting distance information has
been saved to the image, the slider is set automatically according to
this shooting distance information. However, if no shooting distance
information is saved to the image, the slider is set automatically to the
right end at infinity position and a [<!>] appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the
correction items with check marks.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.
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Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.70).

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.88).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.64). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.65).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.51) and/or the color saturation (p.63) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@ The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability or
any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.69). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data] for
the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended

that you set [Sharpness] or [Strength] for [Unsharp mask] for images to O.

® To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
[Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.
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Using the Digital Lens Optimizer

Check the status of [Lens data] for [Digital Lens
Optimizer].

Shoeting distance information

[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [No] is displayed, proceed to step 2. To use the function, you
need to download the lens data for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the image information and shooting information displays.
You can also check it with the menu that appears when you right-
click with the mouse on an image.

If [Yes] is displayed, proceed to step 4.

Click the [[EE] button.

Shocting distance information

The [Add or Remove lens data] window appears.

® To use this function, an environment with Internet access

(subscription to a provider, browser software installed and an in-
place line connection) is required.
An administrator-level privilege is required for this operation.

@ Before you click the [[ifZll] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images.
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Checkmark the checkbox for the lens used to shoot
the image, and click the [Start] button.

Lr] Add or Remove lens data (Version 1.4.20) “
Select a lens category
Ultra wide and wide Macro EF-M
Standard and medium telephoto Zoom
Telephoto EF-5 Select all Glear all
Extender EF1.4% EF2X [ L lenses only
[] EF20-35mm £/35-45 USM A

[C] EF24-70mm /281 I USM

[C] EF24-70mm /261 USM

[] EF24-70mm /4L IS USM

[ ] EF24-85mm £/35-45 USM
EE e f R B T S Th

EF24-105mm £/4L 15 USM )
EF 2o Tamm 7 2oL oo

] EF28-00mm /4-5.§ I

[] EF28-90mm /4-56 USM

] EF28-30mm §/4-55 [T

[ EF28-105mm £/35-45 UsM

[ EF28-105mm /35-45 I USM

[] EF28-108mm §/4-55

[C] EF28-108mm £/4-55 LSM

[] EF28-125mm £/35-56 I3 USM

] EF28-200mm £/35-5 5

[C] EF28-200mm /35-56 LiSM

[[] EF28-300mm £/3 5-5.6L 15 USM

[] EFE5-200mm /4 5-5.6 I USM

[] EF55-200mm /4 5-5.6 LS

[] EF70-200mm §/25L IS USM

[ FEIN-2N0emem £9 81 1ISH

Destination Folder.. Add:1 / Delete:0

v

' Start ' Gancel

Mote

The lens data is downloaded to your computer.

When the downloading of the lens data ends, the indication for
the lens data changes to [Yes].

Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window.

If you remove the check mark from the checkbox for already-
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.

Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.

If you want to change the destination where lens data is saved when
there is already downloaded lens data, move the previously downloaded
lens data from the old folder to the new destination folder manually.

Checkmark the [Digital Lens Optimizer] checkbox
and adjust the image.

& Lens data : Yes
Reverts to its condition
before adjustment

Digital Lens Optimizer

*

0 100

Since the lens data downloaded with DPP version 3.x is not

compatible with DPP version 4.x, the lens data must be downloaded

again.

@ When applying the Digital Lens Optimizer, the effect of [Sharpness]
or [Unsharp mask] may become excessive. It is recommended that
you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0

before using the Digital Lens Optimizer. Adjust [Sharpness] or
[Unsharp mask] again after applying the Digital Lens Optimizer to
images.
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Introduction

Use the slider to adjust the Digital Lens Optimizer effect. C—
If no shooting distance information is saved to the image, the Contents
shooting distance slider is set automatically to the right end at

infinity position and a [<!>] appears above the shooting distance ——

slider. _ ) _ _ _ Downloading
If the lens requires no adjustment with the [Shooting distance Images

information] slider, the slider cannot be used.
Images cannot be corrected for [Chromatic aberration] in the lens
aberration correction tool pallet if the Digital Lens Optimizer has

Viewing
Images

been applied.
In the main window, the [ﬁ] mark is displayed on the image to Sorting
indicate that the Digital Lens Optimizer is applied (p.135). Images
P liag
Adjusting Image Sharpness L

—

You can also use this palette to adjust the image sharpness. For -
information on making adjustments, see “Adjusting Image Sharpness” in 'I’l:::t'gsg
“Editing with the Basic Adjustment Tool Palette” (p.55). 9
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette

You can use this tool palette to erase dust and other marks in a shot
image and to correct an image by copying part of the image and pasting
it onto an unnecessary part of the image.

Note that you can use the functions in this tool palette with JPEG and
TIFF images as well as RAW images.

Dust Delete/Copy Stamp Tool Palette

Tool palette

® On 32-bit OSs, the results of erasing dust manually (repair
function) (p.79) and erasing unwanted parts of an image (copy
stamp function) (p.81) can only be checked in the window in which
erasure was performed, in the print results, or in the image after
being converted and saved.

&pply Dust Delete Data

(Diark)

Performing Automatic Dust Erasure Processing
The Dust Delete Data that is appended to images can be used to
automatically erase dust spots.

Select an image with dust delete data attached in the
main window, etc.
Display the Dust Delete/Copy Stamp tool palette.

You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

Dust spots are erased in a single operation.

Return to the main window.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ Ea3] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.86).

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.79) or the copy stamp function (p.81).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.84).

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image from which you
want to erase dust spots.

Display the Dust Delete/Copy Stamp tool palette.

Click the point from where dust is to be erased.

Click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be

erased.
If the dust spot is dark in color, click the [ Dark) ] button,
and if the dust spot is light in color, click the [ EEEETIN |
button.

When you move the cursor over the image, the dust erasure
range is indicated with [O].

Place the dust spot to be erased within the [O] and
click.

Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots

within the displayed image.
To erase dust in another part of the image, either right-click with

the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.

When the dust spot cannot be erased, [@] is displayed.
Return to the main window.

R
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.81).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ Lz38] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.86).

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.84).

Ny

=< Useful functions of the copy stamp window

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

® For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Introduction

Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Contents

. . . Downloading
Follow steps 1 to 3 in “Manually Erasing Dust (Repair Images

Function)” (p.79).

Viewing

Specify the section to be copied. Images

Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.

Lt

To change the section that is to be the copy source, perform the Isr:;tégg
operation above again.
To fix the position of the copy source, checkmark [Fix Copy :
Source position]. m
Correct the image.
Click or drag on the part of the image you want to modify. [+] in Printing
the window indicates the copy source and [Q] indicates the copy Images
destination.
The copied image is pasted in the position to which it was Processing
Large Numbers
dragged. , , of RAW Images
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
Remote
borders are sharp). Shooting
Return to the main window.
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Preferences
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Setting Work Color Space

A different work color space (p.137) from the default settings (p.130) can
be set for each image.

Display the Settings tool palette » select the color
space to be set.

Settings tool palette

Tool palette

. Eil:lft—pr'ljljf colors

ulation profile

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.130), this
default setting will not be applied and the individually set color space will
remain.

-:@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function

By using the soft-proof colors function, you can apply a selected printing
profile or CMYK simulation profile to the displayed image. The reliability
of the soft-proof colors function depends on the monitor quality, the
monitor and printer profiles, and surrounding lighting conditions where
you are working.

Click the [Settings] button.

The [Color management] tab sheet in [Preferences] appears.

Select the profile to apply from the [Printing profile]
or [CMYK simulation profile] list box, and click the
[OK] button.

Preferences “

General settings Image Proceseing 1 Image Processing 2 | Color mangement | Vien settings

Default settings of Work color space =
® sRGB D Apple RGB
) Adobe RGE *) GolorMatch RGB
O Wids Gamut RGE
[] Use shooting color space as work color space
Golor matching settings
For display
O sRGE
@® Use the 0S settines
") Monitor profile

Printine profils Rendering intents
O Percepiual

@ Felative Colarimetric

GMYK simulation profile
- None -

#Chanees take effect after restarting
oK Gancel

The [Color management] tab sheet in [Preferences] closes.

According to the profile selected in step 2, select
either [Use printing profile] or [Use CMYK simulation
profile], and checkmark the [Soft-proof colors]
checkbox.

The profile selected in step 2 is applied to the displayed image
including its thumbnail.

The profile is not applied to images displayed in the quick check
window.
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JPEG/TIFF

Saving Editing Results

Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu » desired item.

Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+S
Convert and save... Ctrl+D
Batch process... Ctrl+B
Print... Ctrl+P
Print with detailed setting... Ctri+Alt+P
Plug-in printing »
Add to collection Ctrl+G

Remove from collection Ctrl+Shift+G
Clear collection

Select collection »
Delete collection 3
Bookmark

Remove bookmark

Move to Recycle Bin Del

Exit Alt=F4

Your adjustments are saved to the image.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl +Shift+5
(Conver‘t and save.. Ctrl+D ]
Batch process... Ctrl+B
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Plug-in printing 3
Add to collection Ctrl+G

Remove from collection  Ctrl+Shift+G
Clear collection

Select collection 3
Delete collection »
Bookmark

Remove bookmark

Move to Recycle Bin Del

Exit Alt+F4

The [Convert and save] window appears.

Introduction

M —

Contents

N —

Downloading
Images

—

Viewing
Images

Sorting
Images

Editing
| s

—

Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

Specifying
Preferences

\

Reference/
Index

|



Specify the necessary settings, and then click the

[Save] button.

By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.

— Select the save
destination

— Click and save

Enter a file name

6472 x 3648 (6472 pixel x 3648 pixel)
Embed IGG profile

Shoating infa setting  Include all shooting info

Unit |pixel

-] Convert and save [~ |
s nffl || oocc 03 v @3 = m-
b
Recent places M
Desktop
IMG_0001
=
Libraries
This PC
("4 n i, o007 v ‘ Sae ,
e L TIFF 16bit + Exif-JPEG (+ TIF, *JFG} v
Output ssttine
Imase quality 10
Output resolution 350] dpi
[] Resize |
Wit Heieht

and select an
image type

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

|
\\ //
208

To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, saving the image as a separate file (p.84)
is recommended.

@ By saving as a separate JPEG or TIFF image as explained
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.

By saving as explained above, a trimmed image (p.66) or dust-
erased image (p.77 to p.81) actually becomes a trimmed image
or dust-erased image.

You can batch convert and save multiple images (p.116).
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.42 to p.82), so the “original image data itself’
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.66) or dust-erased image (p.77 to p.81) is simply
saved to the image.)

For this reason, you can undo any adjustments saved (p.84) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data

Work color space »

Revert to last saved settings  Ctrl+Alt+Z
Revert to shot settings Ctrl+Shift+Z

The image reverts to the conditions of the selected item.

R
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

"JPEG, TIFF image data |
Image processing conditions information

, . RAW i |mage data:
Image processmg conditions information

I \N
L.drd ]

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).

A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.

Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.

R
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Introduction

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image.

Saving a Recipe as a File

Select an edited image, and then select the [Edit]
menu » [Save recipe in file].

Contents

Select the image with the recipe you want to copy.

To copy all items of a recipe, select the [Edit] menu »
[Copy recipe]. To copy only selected items of a
recipe, select the [Edit] menu » [Copy selected
recipe].
The recipe is copied.
To select recipe items, select the [Edit] menu P [Select and copy
recipe settings] and select items in the window that appears.
After specifying settings, click the [OK] button and close the
window.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

@ When a recipe for an image is copied and applied to an image

in a different orientation, the image orientation also changes.

To prevent the orientation of the image from changing, select the
[Edit] menu » [Select and copy recipe settings] and remove the
check mark from the [Rotate left / Rotate right: 0°] checkbox in
the window that appears.

The [Save recipe in file] dialog box appears.

To save all of a recipe, select the [Save all recipes] option in the
window displayed.

To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the
[Specify Recipe Details] button. In the window displayed,
checkmark the recipe settings to be saved and then click the
[OK] button.

Select the destination folder, enter a file name, and
then click the [Save] button.
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Loading and Applying Recipes

Select the image to which a recipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select a recipe and click the [Open] button.
The recipe is applied to the image.

Introduction

M —

Contents

N —

Downloading
Images

—_—

Viewing
Images

Sorting
Images

Editing
| 3

—

Printing
Images

Processing
Large Numbers
of RAW Images

|

Remote
Shooting

|

Specifying
Preferences

|

Reference/
Index

N —

Q0

©)

{



JPEG/TIFF

Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

In the preview window, display the multiple images
to be compared.

Align the images.
Select the [Window] menu » [Arrange horizontally] or [Arrange
vertically].
The preview windows are aligned.

Select the [Preview] menu » [Sync preview position]
and [Sync preview display size].

Enlarge the image.
Enlarge and display any of the preview windows.

Other preview windows will also be displayed in the same
position/enlargement ratio.

Move the area to be displayed.
If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
To cancel synchronization, select the [Preview] menu » [Sync
preview position] and [Sync preview display size] again.

@ Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not

synchronized.
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Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and
images can be edited efficiently while quickly switching between images
to be edited. Select the images to be edited beforehand in the main
window.

Edit the image.

In the main window, select the images you want to
edit.

Switch to the edit image window.

& Digital Photo Professional 4 - [Folder: C:\Users\xxx\Desktop\xx

File Edit View Thumbnails Preview Label Adjustment Tools Windc

Edit Image Gluick Check Remote She

Folder

Click
The main window switches to the edit image window. e T — e

Edit image window Change the display magnification

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.135).

The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.
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Click the area you want to enlarge.

3]

Click

The area you clicked is enlarged to 100% (actual pixel size).
To change the display area, drag on the image or drag the
enlargement display area (p.17) of the navigator palette.
Click again to revert to the full view ([Fit to window]).

To return to the main window, click the [] button on the
toolbar.

@ With the edit image window, you can only select images from a
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.93).

Changing the Thumbnail Display Position to Horizontal
Select the [View] menu » [Horizontal Thumbnails].

 Di

If you select [Vertical Thumbnails], the thumbnail display reverts
to the vertical position.
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Gathering and Editing Images in the Collection Window

You can gather selected images together in Collection folders for
viewing, comparison and editing.

You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

Click [+ Add collection] in the [Collection] area in the
main window.

|_:3:'

= IMG_D026.CR2

Collection

+  Add callection

A new collection folder is created in the [Collection] area.

Enter a name for the collection folder.

To create additional collection folders, repeat the operation. Up to
20 folders can be created.

Select the [File] Menu » [Select collection], and
select a collection folder to gather images from the
collection folder names displayed.

Select images or image folders in the main window.
Select the [File] menu » [Add to collection].

The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.21) is added, the
number of images is indicated as two images.

You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from
the menu that appears when you right-click the mouse.

Select a collection folder in the [Collection] area.

Collection

B3 001(35)

i@ 002(32)
K3 003(.

Images in the selected folder are displayed.
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Check the displayed images.

Edit the images.

Edit the displayed images.
Displayed images are retained in the collection folders even after
exiting DPP.

® On 32-bit OSs, only up to 1000 images can be displayed per
collection folder. Starting with the 1001st image, images are handled
in the same way as non-supported images. Try to maintain 1000
images or less per folder.

- To remove images from collection folders

Removing selected images

Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, right-clicking
with the mouse, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.

Removing all images

Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.

Deleting a collection folder

Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears when you right-click with the
mouse. Note that if you delete a collection folder, the original images
remain unaffected.

Modifications to the image are applied to the original image

Modifications made to images in a collection folder are all applied to

the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

@ On 32-bit OSs, this function is not available.

@ This function can be used with all image types (p.3) supported by
DPP.
The color space of a composited image will be the color space of
the background image.
Image information is not appended to a composited image.

Select a background image in the main window.

MG 0 CR

B | z D > Y E@E

You can also select a background image from the edit image
window or [Collection] window.

Select the [Tools] menu » [Start Compositing tool].

Start Rename tool Alt+R
(Start Compositing tool Alt+X ]
Start HDR teol Alt+Y
Transfer to Photoshop Ctrl+5Shift+P

Thumbnail display filter settings...

AF point display settings...

Grid display settings...

Highlight/shadow warning display settings...
Preview properties display settings...
Settings for thumbnails with shooting info...
Preview screen display settings...

Customize toolbar..

Print button mode...

Preferences... Ctrl+ K

The compositing tool window appears.

CiUsers\oooodPictures\ioocod IMG_0001.CR2 [5760 x3840] - B

P
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Select the image to combine.
Select the image to combine from the [Foreground Image] list

box.
-

100%0 view

Foreground Image

IMG_0001.CR2 L

Select an image
IMG_0001.CR2
IMG 0002.CR2
IMG_0003.CR2
IMG_0004.CR2

Composite Method

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and [Foreground

Image] is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window:
images in same folder as background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can also combine images of different sizes.

Select a compositing method.

Select a compositing method from the [Composite Method] list

box.
m—

100%% view

Foreground Image

IMG_0002.CR2 W

Position

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.98).

If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).

R
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Position the images.

@ C:\Users\wooood\Pictures\oooo\IMG_0001.CR2 [5760 x3840]

o |

Composite
Weighted

Compose in RAW Format

Weight

Position

100% view

Foreground Image

IMG_0002.CR2

Method

w

50.0 =

Shift large amount (50 pixels)

2
- Shift small amount (1 pixel)
WD m
j Align image centers
x o vpb  H|——— Youcan also directly enter the position
Conte coordinates of the [Foreground Image]
Sove Ao to align it.

Close

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.

[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

5

You can set [Compose in RAW Format] under the following

conditions.

Both the background image and [Foreground Image] are RAW

images, and all the following conditions are met.

» The cameras used to shoot were of the same model

» The ISO speed setting at the time of shooting was the same

» The highlight tone priority setting at the time of shooting was
the same

» The image sizes (original size) are the same

The following functions are not available for images composited
with [Compose in RAW Format].

 Auto Lighting Optimizer (p.54)

* Picture Style Auto (automatically set to Standard) (p.45)

R
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Click the [Save As] button.

Position

"

4

“

Continue

Save As...

Close

Specify the required settings in the window that appears and then
click the [Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The background image and [Foreground Image] are added and
images are combined.

Average

The background image and the [Foreground Image] are combined in
proportions of 50% each.

If you want to change the proportion of the [Foreground Image], select
[Weighted].

Weighted

Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
Darken

The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.

@ You can display this function as a function button in the main
window’s toolbar (p.107).
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JPEG/TIFF

Creating HDR (High Dynamic Range) Images

You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

® On 32-bit OSs, this function is not available.

@ This function can be used with all image types (p.3) supported by
DPP.
Image information is not appended to an HDR image.

Select an image in the main window.

Th
B
B
B

[
o
F
]
=B

Select the [Tools] menu » [Start HDR tool].

Start Rename tool Alt+R

Start Compositing tool Alt+X

(' start HOR tool Alt+Y

Start Dual Pixel RAW Optimizer Alt+D

Transfer to Photoshop Ctrl+Shift+P

AF point display settings...

Grid display settings...

Highlight/shadow warning display settings...
Preview properties display settings...
Settings for thumbnails with shooting info...
Preview screen display settings...

Custemize toolbar...

Print button mode...

Preferences... Ctrl+K

The [Select Images] window appears.
You can also display the [Select Images] window from the edit
window and edit image window.

R
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Specify the required settings, then click the [Start
HDR] button.

(- Select Images H

IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2

Browse... Browse... Browse...

[ auto Align

Close

To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window
appears.

®After using auto image alignment, the periphery of the images is

partially deleted.

Make required selections to adjust the image.
5] Adjust Image = E'

Presets

Natural v

Tone/Color

Brightness: (50)

Saturation: (50)

Contrast:(30)

Detail Enhancement
Strength:(0)

Smoothness:(0)

IMG_0001.CR2 / IMG_0002.CR2 / IMG_0003.CR2

Sliders in [Adjust Image] window
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move

the slider to the right to brighten the image, and to
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image.

[Contrast]:

Move the slider to the right to make the color
deeper, and to the left to make the color weaker.
Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

R
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[Detail Enhancement]

[Strength]: Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.
Move the slider to the right for a smooth and
natural impression.

[Fineness]:  Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing

effects below from a pulldown menu ([Natural] is selected by

default), instead of operating the sliders individually. By selecting

a finishing effect, each slider moves according to the setting. You

can also operate and adjust the sliders after selecting an effect.

[Natural]: In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

[Art standard]: Gives a finish with painting-like tonality for an
impressive image.

[Art vivid]: For a more vivid look than with [Art standard].

[Art bold]: For a more vivid look than with [Art standard],
that makes the subject pop out.

[Art embossed]: Tones down vividness more than [Art standard],
for an old-fashioned feel.

Click the [Save As] button.

Fineness: {0}

Save As...
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Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.

@ You can display this function as a function button in the main
window’s toolbar (p.107).
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Using the Dual Pixel RAW Optimizer

By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.

® Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
Common to all functions
« Effects are most easily gained when the lens aperture value is
/5.6 or lower.
« Effects may be different between shooting in vertical orientation
and horizontal orientation.
* It is recommended that the ISO speed be ISO 1600 or lower.
Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
* It is recommended that the lens focal length be at least 50 mm.
* It is recommended that this function be used when the camera
is at a distance from the subject.”
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m-10m/ 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx. 2 m-20 m /6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx. 4 m-40m/13.1 ft. - 131.2 ft.

@ You can display this function as a function button in the main
window’s toolbar (p.107).

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File

Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

LY C\Users\user\Pictures\xoo0odIMG_0010.CR2 [6720 x 4480] = = “

Checkmark the [Image Microadjustment] checkbox.
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Adjust the image.

& C\Users\user\Pictures\oooed\ IMG_0010.CR2 [6720 x 4480]

Use the slider to adjust the resolution based on depth information
and the level of resolution.

Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.84).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“Reduces the appearance of ghosting in images”.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result

Reposition the viewpoint or foreground bokeh for a more pleasing resuilt,
using the dual pixel information recorded in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.
Checkmark the [Bokeh Shift] checkbox.

Specify the area to adjust.

Ci\Users\user\Pictures\poo0od\IMG_0020.CR2 [6720 x 4480] ~clEl|

»

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.
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Introduction

Adjust the image. .. S —
_ e — Reduces the Appearance of Ghosting in Images .
=3 A\Users\user\Pictures\wcood IMG_0020.CR2 [6720 x 4480] t t
e Reduce the appearance of ghosting in images, using the dual pixel ontents

information in Dual Pixel RAW images.

Use the slider to adjust the viewpoint.

Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.84).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

Resolution may expand in the depth direction according to the
level of adjustment.

If the border of the selected area in the image appears unnatural,
lower the level of adjustment.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Ghosting Reduction] checkbox, and
specify the area.

e

C:\Users\user\Pictures\ioooo\IMG_0030.CR2 (6720 x 4480] = = “

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Any ghosting and flare in the specified area is reduced.
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Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.84).

There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.

There may be cases where the border of the selected area in the
image looks unnatural.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reposition the viewpoint or foreground bokeh
for a more pleasing result”.
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Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
atime, see p.118.

@ Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.136) is added. The ICC profile
contains information about [Preferences] (p.130) or work color
space (p.82) set for each image as described and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.
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Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main
window’s toolbar.
You can also change how the buttons are laid out.

Select the [Tools] menu » [Customize toolbar].

The [Configure Toolbar] window appears.

Select functions to display in the toolbar.

Configure Toolbar H

Select items to show in the toolbar.

Print Move Up

Maowve Dowvn

HOR. Tool
Dual Pixel RAW Optimizer
Photoshop

Close

To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.

After specifying settings, click the [Close] button and close the
window.

The settings are applied to the main window’s toolbar.

 E———
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5 Printing Images

PrintinganImage .........ccoooiiiiiii i, 109
Printing with Shooting Information......................... 110
Printing a Thumbnail List (Contact Sheet

Printing) «oceeeeeeeieee e 111
Plug-in printing.........ccooeiiiii e 112
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the image to be printed.

Select the [File] menu » [Print].

Close window Ctrl+W
Save Ctrl+S
Save As.. Ctrl+5Shift+5
Convert and save... Ctrl+D
Batch process.. Ctrl+B

( Print. Crl+p )
Print with detailed setting... Ctrl+Alt+P
Plug-in printing 3
Add to collection Ctrl+G

Remove from collection Ctrl+5Shift+G
Clear collection

Select collection 3
Delete collection 3
Bookmark

Remove bookmark

Move to Recycle Bin Del

Exit Alt+F4

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for printing photographs in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.

R
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

>

C:A\Users\xoo\Desktop\oceo 03\IMG_0001.CR2 x|

Printer | Image | Text SetﬁngsJ

Printer:

200K v

Properties...

Media: 297.0mm x 210.0mm
A4 v

Media orientation:

() Portrait (®)Landscape

Media type:
Print Quality:
Borderless:
Print profile:
CMYK profile:

CMS settings...

Print Cancel Apply

Print preview

The image can be moved by dragging.
Drag the four corners of the image to change the size.

For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that appears.

To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can be applied to another
image when printing.

Memorized settings are options in [Printer], [Media], [Media orientation],
[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

Select the [File] menu » [Print contact sheets].

Specify the required settings for printing, and then

click the [Print] button.

Switches the settings tab sheet

o

Contact sheet

Frinter | |mage | Text Settings]

Frinter:

IO »

Properties...

Media: 210.0mm x 297.0mm
Ad W

Media orientation:
(®) Portrait () Landscape
Media type:

Print Quality:

Borderless:

Print profile:

CMYK profile:

CMS settings...

' Print ' Cancel Apply

Print preview

-Z\@/i— To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.

Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.

@ You can set printer profiles (p.130).
If CMYK simulation has been set, the image is printed in the set
colors (p.130).
By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.

R
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Plug-in printing
Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for printing
photographs and then print.

 E———
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6 Processing Large Numbers of RAW Images

Batch Apply White Balance to Images

(Personal White Balance)..........cccccoooeveviiiieieenennnn,
Registering Personal White Balance.........................
Applying Personal White Balance ...............cccc.........

Batch Save as JPEG or TIFF Images (Batch
Processing)....cccoeuveeriiiiiiieeeice e
Batch Transfer Images to Image Editing Software .........

Batch Change the File Name of Images................
Changing the File Name of Images in the Order
in the Main Window ...
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Personal white balance data for versions before DPP 4 cannot be
applied.

Registering Personal White Balance

Adjust the white balance (p.48, p.49).
To adjust white balance, select a setting other than [ ()] from
the [White balance adjustment] list box (p.47). Registering the
adjustments is not possible if [ ()] is selected.

In the Basic adjustment tool palette, click the
[Register] button.

The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance H

Register current setting in personal white balance

Save..

? To use the registered personal white balance on another
computer

In step 3, click the [Save] button to write as a file.

Copy the file to another computer.

In DPP on another computer, display the window of step 3.

Click the [Load] button and in the window that appears, select the
copied file.

@You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Applying Personal White Balance

In the main window, select the image to which a
personal white balance is to be applied.

Select the [View] menu » [Tool palette].
The tool palette appears.

Click the personal white balance number button that
is to be applied.

Tool palette

Fine-tune

B A
B —— o=
A G
| | -——

Auto Lighting Optimizer |,

(= Standard Strong
Ficture Style
Y (landscape) - =
Gamma adjustment

B Linear
2 0

A0

. b ol
Personal white balance is applied to all the selected images.

R
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Select the [File] menu » [Batch process].
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_0001 GR2 Destination falder

IMG_0002CR2 (®) Same as original files
mggggig:g () Use this falder

IMG_0005GR2 G\ Uszers\uzer\ Pictures
IMG_D006 GR2
IMG_0007CR2
IMG_D008GR2 Exif-JPEG Subfolder name  JPEG
IMG_0009CR2
IMG_0010GR2 Cuitput setting

IMG_0011GR2 .
IME_D012GR2 Save as type Exif-JPEG (*.JPG) - Tmage quality 10

[] Greate storage sublaldsrs for sach fils typs

IMG_0013GR2
IMG_0014 GR2 Output resolution 360 dpi
MG_0015GR2
IMG_0017GR2 [ Resize v

MG_0018GR2 Wit Height

IMG 00 18.CR2 5172 3615 (5472 pixel x 3648 piel) Unit [piee]
IMG_0020GR2
MG D021 CR2 Embed ISC profile
MG 0022 GR2
[MG._0028GR2 Shooting info setting Include all shooting info
MG 0024 GR2
IMG_0025GR2 -
MG 0026 GR2 File name

IMG_0027 GR2 ® Gurrent file name
MG 0026 GR2

M 002853R2 ) New file name

IM3_D030CR2 String Additional string
IMG_0031CR2 annnannt
IMG_0032GR2 7|

IMG_00335R2
Ex.: IMG_0001.JPG, IMG 0002.0PG

Image transfer settings

[ Open imags using saftware

Convert RAW images only Cancel

Batch settings H

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

If you have selected [New file name] in [File name], [Sequence
number] has to be set.

By saving as explained above, a trimmed image (p.66) or dust-
erased image (p.77 to p.81) actually becomes a trimmed image
or dust-erased image.

You can also use this function in the editimage window. However,
all images in the window (not only the selected ones) are
converted and saved.
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? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.84) to edited RAW images.

A/

5@3 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.

-:@/3 Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike Select Photoshop.
“Transferring a RAW Image to Photoshop” (p.106), you transfer images In the [Open] dialog box, select a Photoshop file or a shortcut
that have first been converted and saved as a separate image, so the and click the [Open] button.

transferred image will not be deleted after exiting the destination . , :
software. The software used here as an example is Adobe Photoshop. F;;égzz;]indégov%i:gz)(v:l;s::tatgdpﬂr;zgﬁ;;anSfer settings] in the

In the main window, select multiple images to be Click the [Execute] button.
transferred. The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop starts up

Select the [File] menu » [Batch process]. and transferred images are displayed in transferred order.

The [Batch settings] window appears.

Perform settings required for transferring (e.g. file

format).
Checkmark [Open image using software].
Batch settings E

IMG_0001 GR2 Destination folder

IMG_0002GR2 ®) Same as original files

mgigggiggg () Use this folder

IMG_0005GR2 Ci\Usersluser\Pictures

mgggsgggi [[] Create storage subfalders for each file typs

IMG_0008 GR2 Exit-JPEG Subfolder name  IPEG

IMG_0009 CR2

IMG_000GR2 Qutput setting

IMG_0011GR2

IMG-U[I]E.ORE Save as type Exif-JPEG (x JPG) - Image quality 10

IMG_0013GR2

MG D014 SR2 Output resoltion 350 dpi

e e s :

MG _0013CR2 Width Height

IMG_0N8CR2 5472 % 2648 (6472 pixel x 3648 pixel) Unit |pixel

IMG_0020CR2

IMG_0021 GR2 Embed IGC profile

IMG_0022 GR2

mg—ggig:g Shooting info setting  Include all shooting info

G025 CR2

IMG_0026GR2 File name

IMG_0027 GR2 (@) Current file name

1MG.0028 GR2 ) New file name

mg'ggggggg String Additional string

IMG_0031GR2 00000001

IMG_0032GR2 -

MG _0083CR2

Ex. IMG0001.JPG, IMG 0002 JPG
et e @ To reset the transfer destination to another software, click the
[ Open imaee usine software . . .
- [Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
Ganvert RAW images anly Gancel
button.
The [Open] dialog box appears. You can also use this function in the edit image window. However,

all images in the window (not only the selected ones) are
transferred.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

a C\Users\ood\ Desktop\aooae_03\ -0

File name Extension
DPP v || Shooting Date/Time v || Sequence number v | Do not change v
Basic Settings Format settings
Sort Sequence number
®) Fit to main window 0001 []Save sequence number
") File name
Shooting Date/Time
Shooting Date/Time
Day Month Year v

Same file name for RAW +IPEG images
DD-MM-YY v

[[] copy and Rename
Insert underbar
Users\xood Pictures

Original File Name Modified Fie Name
IMG_0001.CR2 ~ DPP_08-08-12_0001.CR2
IMG_0001.JPG DPP_08-08-12_0001.JPG
IMG_0002.CR2 DPP_23-06-12_0002.CR2
IMG_0003.CR2 DPP_09-08-12_0003.CR2
IMG_0004.CR2 » DPP_10-08-12_0004.CR2
IMG_0005.CR2 DPP_10-08-12_0005.CR2
IMG_0006.CR2 DPP_12-08-12_0006.CR2
IMG_0007.CR2 DPP_12-08-12_0007.CR2
IMG_0008.CR2 . DPP_12-08-12_0008.CR2

( Execute Cancel

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is
duplicated. Changes cannot be made if even one file name is
duplicated. Change the settings so that duplication does not occur.

@ You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.

You cannot start up the rename tool from the [Collection] window
(p-93). You also cannot change the file name of one image.

Changing the File Name of Images in the
Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p-34).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

@ C:\Users\xxx\Desk|

File name
DPp v | Shooting Date/Time

Basic Settings

Sort

(@) Fit to main window

(_) File name

(_) Shooting Date/Time

Specify the required settings.
To copy an image, checkmark [Copy and Rename].

Click the [Execute] button.

The file names are changed and the order in the main window is
maintained.
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7 Remote Shooting

Remote Shooting..........ccoooiiiiiiiii,
Registering Click White Balance in the Camera
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RemOte ShOOti ng Introduction

To save to the currently selected folder, select [Current Folder].
To create a new folder for saving images, select [Use this folder],
click the [Select] button, then select the destination and enter a Contents

You can perform remote shooting by using “EOS Ultility” which enables
communication with a camera in combination.

For remote shooting, “EOS Utility Ver. 3.x” must be installed on your

M —

computer. For information on cameras compatible with “EOS Utility Ver.

—_—
3.x”, refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual After specifying settings, click the [OK] button. _
in PDF format). This function is not available on EOS M series cameras The remote shooting window appears. D°‘|”n"‘;°ae‘;'“9
or PowerShot cameras. 9

Click the [Remote Shooting] button on the toolbar in

the main window.

(& Digital Photo Professional 4 - [Fol Sortlng
File Edit View Thumbnails P Images
_—
Edit Irage
Editing
Boak mark I ma g es

-89 Librories 'ﬁ'lih" Printing
i T Images
Remote shooting setting window appears.
N . . . P i
Set the [Destination] in the Specify Remote Shooting Lar;zcﬁﬁmgers
Folder window. of RAW Images

name for [Destination folder].

Viewing
Images

—_—
)

Specify Remote Shooting Folder “
Deztination
() Gurrent Folder
Gl Uzers Voo oo\ soooo Specrfyl ng
@ Use this folder Preferences
Cob Ugers oo oo Select... -
Destination falder
Reference/
Mew folder 1 Index
File Mas —
Do not madify ] Settings.. @ @

)

—

121



@ You can change the [File Name] for Specify Remote Shooting
Folder window.
(If [Do not modify] is selected, images are saved with the file names
set on the camera.)

Click the [Settings] button to display the Set file name for captured
image window.

Set file name for captured image E

Do not modify W
File Prefix Customize...

IMG

Aszign Sequence No.
Mumber of Digits 4
Start 1

Shooting Date Format | Day Month Year v Delimiter |Underline w

DD-MM-YYYY v

[ OK ] Cancel

Select a naming rule for image file names from the list box.

You can click the [Customize] button and customize naming rules

for file names.
You can individually set prefix characters, number of digits for
serial numbers, and the start number for file names.
If you are using the shooting date in file names, you can specify
the date format (order and style for year-month-date) and
dividing characters on the Set file name for captured image
window.

After specifying settings, click the [OK] button.
The Set file name for captured image window closes.
Atfter clicking the [Remote Shooting] button, you can click the
[m] button at the bottom right of the main window to show/
hide the [Camera Control] palette.

You can perform shooting while checking the image by switching

the window to multi-layout.

Connect a camera and a computer, and set the

camera’s power switch to <ON>.

Click the [Live View] button.

Camera

EOQE Xk

1550 F40 ISO400

ubfolder

t

R

to
HHHHIHHLLE, -

s*0

Settings

Live View window of “EOS Utility” appears.
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Specify the required settings.

Lo

Remote Live View window

WhiteBalance

LV_ClickwB

Apply to shot images

oo lolcl Ju - =il o | o |

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

Click the [Settings] button.

Can

Camera

EOQE Xk

1550 F40 ISO400

bfalder

Ree

to:
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The capture window of “EOS Ultility” appears.

Specify the required settings.
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Introduction

M —
Registering Click White Balance in the Camera .
ontents
During remote shooting, you can register click white balance to the

connected camera. To use this function, EOS Utility version 3.4.20 or
later must be installed on your computer. Downloading
This function is not available on EOS M cameras or PowerShot Images

cameras.

—

The shot image is displayed.

The shot image will be saved in the folder created in step 2.

The images in the folder mentioned above will be displayed in
the thumbnail display area.

You can also create a sub-folder in the folder mentioned above to
save images. To create a sub-folder, click the [Create subfolder]
button on the remote shooting window, enter [Folder name] on
the screen appeared, then click the [OK] button.

@ Do not exit “EOS Utility” when remote shooting is being set or

5

performed.

In the cases below, perform shooting with EOS Utility.

* You want to autofocus with EOS Utility’s shoot button

* You want to perform continuous shooting

You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.19). This is convenient for
image selection.

Display the shot image to be used as the standard
for white balance.

This function supports only RAW images with a “.CR2”
extension.

Select the destination where to register click white
balance.

EQS KK

160 F40 Iso400

Reeigtered to :

EEEeeee sy -

Z3s

Select the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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Select a point that is to be the standard for white
balance in the shot image, and register the white
balance in the camera.

EQE HKK

1/60 F40 IS0400

subfolder

s 07 =

Ree

red to
HRHRNXHEHX -

Click the [[EZT=M] button, and in the displayed image in step 1,
click on a point that is to be the standard for white balance with
the mouse.

The white balance is registered to the destination selected in
step 2, and applied to displayed images.

Click [[IEZI=H] again to exit the function.
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8 Specifying Preferences
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]

window. Check the contents of each window and set.

Refer to the detailed explanations if available, as well as to each

window.

Select the [Tools] menu » [Preferences].

The [Preferences] window appears.

Select a tab sheet, specify the settings, and then

click the [OK] button.

Preferences

' f General settings | Image Processing 1 Image Processing 2 Color management Wiew settings

)

(®) Last displayed folder
() Specified folder

Save recipe
@® Display message when adding file
() #dd to file sutomatically
Movie file playback
Flay with EOS MOVIE Litility
WMovies that cannat be played with EOS MOVIE Utility are passed to the default application

Receiving files from external applications
[ Automatically facus files received

Default walue of output resalution *
50| dpi( 1-60000)

Temporary Filest

*Changes take sffect after restarting

G#lsers¥usersPictures Browsze.

Gurrently used 11 M8 Delete Reset
Amount of Dual Pizel RAW cache used 3529 MB Delete

Maximum available on disk 4GB 0 2

Destination Gi¥Users¥user¥ AppData¥ Roaming¥Ganon Tne 15 Browse

General Settings

You can specify the folder that opens when DPP is started up, saving of
recipes, etc.

Preferences E
General settines | Inage Processine | Image Processing 2 Color management View settines
Startup folder *
@ Last displayed folder
() Specified folder
Ciélisers¥usartPictures Browse

Save recipe
@® Display messaze when adding file

) Audd to file autematically

Movic file playback
Play with EOS MOVIE Utility
Movies that cannot be played with EGS MOWIE Uility are passed to the default application.

Receiving files from external applications
[ Automatically focus files received

Default value of output resalution *
30| dpil 1-60000)

Temporary Files*

Gurrently used 11 ME Dekete Reset
Amount of Dual Pixel RAW sache used 3529 MB Delete
Maximum available on disk 4GB0 82
Destination G UsersuserfippData¥Roaming¥Canon e I Bronse
#Chanees take effect after restarting e

Movie file playback
You can change the movie playback application to EOS MOVIE Utility.
Movies that cannot be played back with EOS MOVIE Utility are played
back with the movie playback application specified with the computer’s
OS settings. For detailed instructions on EOS MOVIE Utility, refer to the
EOS MOVIE Utility Instruction Manual.

® If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.
If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.
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Default value of output resolution
When saving JPEG or TIFF images created by converting RAW images
(p.84, p.116), the resolution of the JPEG or TIFF images can be set.

Temporarily saved files

You can delete temporarily saved files that were created and improve
operation speed, change file save destinations, or set a limit on disk
usage. Any changes you made will be applied when you start up DPP

again.
[Delete] button:

[Maximum available on disk]:

[Destination]:

[Reset] button:

Click the [Delete] button to delete
temporarily saved files.

Set with the slider (setting range: 0 to
32 GB).

Once usage reaches the limit, files
are erased starting with the oldest.
Click the [Browse] button to change
the save destination in the dialog that
appears.

Click the [Reset] button to revert all
changes to the original settings.

® On 32-bit OSs, only deleting temporarily saved files is

possible.

Image processing
You can specify settings for processing images in DPP.

Image Processing 1

Preferences

Gerneral settings

JPEG image quality *
[] Remave block naise and mosquita noise

Modified Picture Style settings *
Retain settings of each Picture Style

Preview image ssttings

Show stamp editing status on preview imazes
Select to show stamp editing status on sl
Clear

| previem screens
t show stamp editing status only on the stamp editing screen.

Noize reduction defaults*

() Set as defaults
0.0
0.0

Sharprisss defaultst

() Set as defaults

Unsharp mask.

0.0
0.0
0.0

*Changes take effect after restarting

rocessing 1 Image Frocessing 2 Color mansgement Wiew settines

@® Apply camers ssttings Applies to RAW images only

@® Apply camera settings Applies to RAW images only

JPEG image quality
[Remove block noise and mosquito noise]

You can improve the quality of a JPEG image by reducing the noise

particular to JPEG images.

This setting is also effective when RAW images are converted to
JPEG images and saved (p.84, p.116) and for JPEG images that to
be saved with a different name. The higher the JPEG image’s
compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings

If you checkmark the checkbox, setting values for [Color tone], [Color
saturation], [Contrast], [Unsharp mask], [Sharpness], and other options

will be retained for each Picture Style.
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Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.

For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.

Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
When [Apply camera settings] is selected, you can pre-set a

sharpness that suits the camera settings beforehand as the default.

When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.

For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.

For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

@ On 32-bit OSs, the [Preview image settings] menu is not
displayed.

Image Processing 2

Preferences “

Gereral settings Image Processing | | Image Frocessing &1 Galar Wiew settings

Quick check window settings¥

@® Show ariginal image

) Show imags with recipe applisd

Use eraphics processor to speed up preview display

#Changes take effect after restarting

Quick check window settings
You can specify image display settings for the quick check window. By
selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.

Graphic processor settings
If you checkmark [Use graphics processor for image processing], the
graphics processor is used to allow a faster preview display. The CPU
handles convert and save tasks as well as print tasks as usual. Settings
will be applied the next time DPP is started up.
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To use this function, a NVIDIA CUDA (Compute Capability 2.0 or
higher) GPU* with at least 1.0 GB of video memory is necessary.
Additionally, the latest NVIDIA GPU driver must be installed.

* GPU is an abbreviation of “Graphics Processing Unit”.

The [Use graphics processor for image processing] checkbox is
available only when a supporting GPU is installed.

If the OS or other application software is using the GPU,
processing by the GPU may not be possible in some
circumstances. In such a case, the CPU handles processing as
usual.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences “

General settines Image Processing 1 Image Processing 2 | Color marsgerent View settings
Default settings of Wark color space *
® sRGBE © Apple RGB
) Adobe RGE ) ColorMatch RGB
) wide Gamut RGE
[] Use shooting color space as work color space
Golor matching settings
For display

O sRGE

(@) Use the OF settines

© Monitor profile

Browse

Frinting profile

‘,,, [Te— = ‘ Perceptual

® Relative Colorimetric

GMYK simulation profile

‘,,, HNors —- = ‘ Perceptual

® Relative Golorimstric
#Changes take effect after restarting
onc

Default settings of Work color space

You can select the color space (p.137) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved (p.84,
p.116) or printed (p.109 to p.112).

If you change the color space, and you restart DPP, the set color

space is applied as the default color space.

You can check the color space that is set in an image in all windows

except the quick check window.

If you checkmark [Use shooting color space as work color space],

the color space specified with the camera when the image was shot

will be set as work color space.
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:@: Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, cropped, dust-
erased) images. Change the settings individually.

@ You can set a color space that is different from the default settings
for each image (p.82).

Color matching settings (color setting of the monitor)
Where a profile (p.136) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP. If you are using multiple monitors, the
profile set for each monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button. You can
select a profile for your monitor in the dialog box that appears.

Ay

5@3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Printing profile (color setting of the printer)
Where a profile is not attached to the printer you are using to print
images, you can print an image, simulating the colors displayed on
screen by setting the profile in DPP.

@ When you set a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.

View Settings
Preferences “
General sattings Image Processing | Image Processing 2 Golor managsment | Wiewsettngs
Thumbnail order
[] Retsin sart order
Glearing this option will discard the order of any thumbnails you have rearraneed, in all folders.
Tool tips
Show tool tips
Reset user interface *
[] Restare defaults at startup
nd position only
Reset il user interface settings
Image backeround color
Freview screen backeround color B (defaul) -
Image zooming
(®) Single-click O Double-click.
#Ghanges take effect after restarting
Gore

Thumbnail order
You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.34).
If you checkmark the checkbox, the order of the rearranged images is

maintained even if you exit DPP or select another folder in the folder area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you exit DPP or
select another folder in the folder area.

Reset user interface
You can reset user interface settings.
Choose from either of 2 reset states.
By checkmarking the [Restore defaults at startup] checkbox, settings
revert to their original settings for next time you start up DPP. The
checkmark is also removed from the checkbox for the next startup.
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Introduction

Troubleshooting

If DPP is not operating correctly, refer to the subjects below.

A recipe could not be pasted (applied) to another image

Installation can not be completed correctly

Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) when setting the user. You cannot install the
software if the user setting other than an administrator-level privilege
is selected. For detailed information on selecting an administrator-
level privilege, refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
may not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility.

Images are not displayed properly

Images that are not supported by DPP are not displayed. (Thumbnail
images are displayed as [?].) On a 32-bit version PC, when more
images than the maximum displayable amount are detected, images
beyond the maximum are not displayed. (Thumbnail images are
displayed as [?].) There are various types of JPEG and TIFF images,
so JPEG images other than Exif 2.2, 2.21 or 2.3 compatible images
and TIFF images other than Exif compatible images may not to be
displayed properly (p.3).

Contents that can only be adjusted for RAW images cannot be
applied as a recipe to JPEG images or TIFF images.

Colors are subdued in the image when viewed with
other software

If a RAW image which has a color space other than sRGB is
converted and saved as a JPEG or TIFF image (p.82, p.130), the
colors will be subdued when viewed in software that is only
compatible with sRGB color space. In such a case, set the RAW
image’s color space to sRGB, convert and save again as a JPEG or
TIFF image, and then view the image.

The Auto Lighting Optimizer (p.54) is a function compatible with
cameras equipped with the Auto Lighting Optimizer.

Adjustments made with the Auto Lighting Optimizer cannot be applied
to RAW images shot with the cameras not compatible with this
function.

The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if the profile for a printer that is to print image is not set
up, the color of the image displayed on screen and the color of the
printed photograph may differ greatly. If the color of the monitor that
displays images is corrected (p.130) and the profile for a printer is set
up correctly (p.130), the color of a printed photograph and the color of
an image on screen can be more closely matched. Using a Canon
printer automatically sets up the profiles for the printer, so you only
need to set the color of the monitor to bring the colors closer to each
other.

Printing a large number of images in batches
cannot be performed
If a large number of images are printed in batches, printing may stop

in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.
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Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

Uninstall the software according to the OS software uninstalling
method.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.
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Image Frame Information in the Main Window and Edit Image Window (.11, p.91)

Trimming (cropping) range*2 (p.66)

Check mark (p.31, p.32) Pinned image setting mark

(p.19)

Image type

Multiple image display mark
(p.20)

INHG_D003.CR2

IMG_0030.CR2

File name

Rating mark (p.31, p.32) GPS mark 3 Lens aberration correction mark (p.70)

Digital Lens Optimizer mark (p.74) L Unsaved editing content mark

+ Displayed on RAW+JPEG images displayed as a
single image (p.13).

[[_LR_]]is displayed in RAW images.

[[BPR]] is displayed in Dual Pixel RAW images.

*2 When aspect ratio information is attached to an image
shot with any supported camera other than the EOS 5D
Mark 11, the image is displayed as a cropped image.

*3 Displayed on images shot on a GPS function-
compatible Canon camera.

[] is displayed in an image frame when editing is not possible.
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Glossary
RAW image

EOS camera RAW images are recorded in an uncompressed 14bit or
12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

Standard color space for Windows. Widely used for
the standard color space of monitors, digital
cameras, and scanners.

A wider color space than sRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

ColorMatch RGB : A slightly wider color space than sRGB. Mainly

used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Y

0.8

sRGB
—— Adobe RCE
-------- Apple RGB
————— ColorMatch RGB
———— Wide Gamut RGB

Color range that can be
seen by the human eye

08 X
Gamma White point
value (color temp.)
sRGB 2.2 6500K(D65)
- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
—————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.

Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
All other trademarks are the property of their respective owners.
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